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NetWitness Endpoint

Note: The information in this topic applies to RSA NetWitness® Platform Version 11.1 and later.

About NetWitness Endpoint

NetWitness Platform provides an endpoint detection and response solution that continuously monitors the
behavior of all endpoints in and outside the network to provide deep visibility and analysis of executables
and processes. It helps to detect new, unknown, and targeted attacks, highlights suspicious activity for
investigation, exposes anomalous behaviors, and determines the scope of compromise to help analysts
respond to advanced threats faster. During investigation, the analyst can use the visual indication of
threat level to assess the risk of endpoints.

As part of this solution, NetWitness Platform introduces Endpoint Log Hybrid that:

o Collects and manages endpoint (host) data from Windows, Mac, and Linux hosts.

o Collect log files and Windows logs from Windows hosts.

« Generates metadata to correlate endpoint data with sessions from other events sources, such as logs
and network.

Analysts can:

o Perform instant scans for detailed insights of the host behavior at any point in time.

o Analyze the scope of the attack across hosts and network through integrated metadata.

« Quickly triage and focus their investigation by managing suspect and legitimate files.

o Perform multiple checks of file legitimacy to determine if a file is malicious, including checking file
certificates and hashes.

« Blacklist malicious files and then block them across all hosts in the network to prevent future
execution of this file on any host.

o Download Master File Table (MFT), system dump, and process dump for forensic investigation.

« Isolate host from the network to safely investigate possible threats within the host.

6 NetWitness Endpoint
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Endpoint Log Hybrid receives data from the Endpoint Agents. The following services run on the
Endpoint Log Hybrid:

« Endpoint Server: Manages data received and stores it in a database. It parses the events, generates
metadata, and forwards it to the Log Decoder through protobuf.

Note: You may need to install your Endpoint Server on separate hardware from your Log Decoder.
If you are only using NW Platform for collecting and analyzing logs, you can co-locate your
Endpoint Server on the same physical hardware as your Log Decoder. For more information, see
the Prepare Virtual or Cloud Storage topic in the Storage Guide for RSA NetWitness® Platform
11.x.

If you exceed these guidelines, the amount of disk space usage and CPU might become so high as
to create alarms for your Endpoint Server in Health and Wellness. If you notice this, and are
running both log collection and EDR scans, you can use Throttling to control the amount of data
coming into the Log Decoder.

If that doesn't help, RSA recommends that you move your Endpoint Server onto separate hardware
from that used by your Log Decoder.

o Log Decoder: Captures data from the Endpoint Server and processes the metadata.

« Concentrator: Aggregates metadata from the Log Decoder and makes it available for all upstream
components like Investigate, Reporting Engine, Respond, and Event Stream Analysis similar to
NetWitness Decoder and Concentrator.

« Log Collector: Collects logs from all event sources that are supported for the log collection in the
NetWitness Platform.

In addition to the above services, the Endpoint Log Hybrid leverages the following services:
« Event Stream Analysis (ESA): Creates alerts from ESA rules for Endpoint data.

« Endpoint Broker: Provides a consolidated view of all Endpoint servers in a multiple Endpoint Log
Hybrid deployment.

Endpoint Agent Data Flow

The following figure shows the endpoint data flow from the agent to the NetWitness Platform:

NetWitness Endpoint 7
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The Hosts and Services Getting Started Guide provides the information you need to understand and
install all the NetWitness Platform services.
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Basic configuration involves:

« Installing agents on hosts

Deploying the ESA rules from the Endpoint Rule Bundle

Creating groups and policies

Configuring Endpoint metadata forwarding and retention policies

Defining health and wellness policies to monitor Endpoint Server

Installing and configuring Relay Server

You can configure the required settings in the NetWitness Platform user interface under Administration

<4
Services Config view ( (Admin) > Services > Endpoint Server > Config).
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Agent Modes

Note: The information in this topic applies to RSA NetWitness® Platform Version 11.3 and later.

In NetWitness Platform 11.3 and later, the Endpoint agent can operate either in Insights or Advanced
mode depending on the policy configuration. For more information on policy configuration, see the
NetWitness Endpoint Configuration Guide. Y ou can have both Insights and Advanced agents in a single
deployment.

There is no license required for the Insights agent. However, you must procure a license for an
Advanced agent. For more information on licensing, see the Licensing Management Guide.

The following table list the features supported for Insights and Advanced agents:

Insights
Advanced Agent

Agent

Scan data - Yes - Windows,  Yes - Windows, Mac, and Linux

g g Mac, and Linux
Processes, Autroruns, Files, Drivers, >

Libraries, and System Information

Tracking data - No Yes - Windows and Mac
Process, File, Registry, Network, and Registry and Console events are
Console applicable only for Windows.
Expanded network visibility Yes - Windows Yes - Windows

Anomaly detection - No Yes - Windows

Image Hooks, Kernel Hooks, Registry
Discrepancies, and Suspicious Threads

Windows log collection Yes Yes
File log collection Yes - Windows Yes - Windows
Threat detection content - Yes Yes

ESA, Application Rules

Analysis of downloaded file No Yes

File status - Yes Yes

Whitelist, Blacklist, Graylist, and Neutral (View only) (View and modity)
File remediate (Block) No Yes - Windows
Process visualization No Yes

Live connect Yes Yes

File reputation service Yes Yes

(Third-party lookup)
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Advanced Agent

Insights
Agent
Risk score for hosts No
MFT, process dump, and system dump No
download
Automatic file download Yes
Manual file download No
Network isolation No
Relay server Yes

Yes
Yes - Windows

Yes
Yes
Yes - Windows

Yes

Agent Modes
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Endpoint Log Hybrid Configuration

This topic provides the high-level tasks required to configure the Endpoint Log Hybrid.

Install Endpoint
Log Hybrid

Deploy
Application and
ESA Rules

Generate Agent
Installer

= Install Agents
on Hosts
through third-
party tool

(Optional)
Install and
Configure Relay
Server

Configure
Metadata
Forwarding

Manage Endpoint
Settings

Data Retention
of Endpoint
Data
Manage
Inactive Agents
Retention of
Memory
Dumps and
Master File
Table (MFT)

Define Groups
and Policies

Analyze Event Data
(Navigate and
Events View)

Investigate
Endpoint Data
(Hosts and Files
View)

Analyze Endpoint
@ Data [Navigate and
Events View)

Analyze Process
(Hosts View)

Generate Reports
and Alerts

Install the See the Physical Host Installation Guide and Virtual Host Setup Guide.

Endpoint Log

Hybrid

Deploy See Deploying Endpoint Application Rules and ESA Correlation Rules.

Application

and ESA

Rules

Configuring  Similar to logs and packets, you can view Endpoint metadata in the Navigate and

Metadata_ Events view. You can also generate reports and alerts for the Endpoint data. By

Forwarding default, the Endpoint Meta option is disabled. The agent must be installed with the
Endpoint Meta option enabled to forward metadata.
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Install
Agents on
Hosts

Install and
Configure the
Relay Server

Endpoint
Sources

Enable
Reputation
Status

Risk Score

Configuring
Data

Retention
Policy

Managing
Inactive

Agents

Configure
Retention
Policy for
Memory

Dumps and
MFT

The Endpoint agent installer is generated using the Packager tab under (Admin)
> Services > Config > Endpoint Server from the NetWitness Platform user
interface. The Packager is a zip file that contains executables and configuration files
for generating agent installer for Linux, Mac, and Windows operating systems. Y ou
can install only one version of the agent on a host. If you have a previous version of an
agent installed (for example, 4.4), uninstall this agent to install the 11.5 agent.

After the agent is installed, it appears on the Hosts view. By default, the Endpoint
data is posted for the first time. To collect subsequent Endpoint data, you have to
either schedule a scan or perform ad hoc scan. It retrieves data, such as drivers,
processes, DLLs, files (executables), services, autoruns, security information,
anomalies, system configurations, and scripts found on the host.

Note: In Version 11.5.3 and later, if there is no direct network connection available
to the Endpoint server on a Windows host, the Endpoint agent communicates through
proxy server if it is enabled and configured in the host (System > Proxy settings). If
both Automatic (Auto detect / Setup Script) and Manual proxy settings are enabled
and configured, the order of precedence in selecting the proxy is as follows:

1. Manual proxy setup

2. Automatic proxy setup - Use setup script

3. Automatic proxy setup - Automatically detect settings

See (Optional) Installing and Configuring Relay Server.

To efficiently manage and update endpoint agent configurations, you can group the
agents, and manage their behavior using policies.

Reputation Status is enabled by default in an NetWitness Platform 11.3 and later
deployment and displays information about the file. For troubleshooting, see the Live
Services Guide.

Risk Score is calculated and obtained from NetWitness Respond for hosts and files.
For more information, see the NetWitness Respond Configuration Guide.

Define data retention policies to optimally store and manage the Endpoint data based
on the age of the Endpoint data or the storage size.

By default, 30 days of agent data is retained.

By default, agents (including all the collected Endpoint data) that have not
communicated with the Endpoint Server for 90 days will be automatically deleted.

Define retention policy to optimally store and manage downloaded system dump,
process dump, and MFT. By default, 90 days of data is retained.

Endpoint Log Hybrid Configuration 13
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Investigate You can investigate the Endpoint data in the Hosts and Files views. For more
Endpoint data information, see the NetWitness Endpoint User Guide.

14
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Deploying Endpoint Application Rules and ESA

Correlation Rules

Note: The information in this topic applies to RSA NetWitness® Platform Version 11.3 and later.

The existing IIOCs from NetWitness Endpoint 4.4.0.x are now available as OOTB Endpoint Application
rules tagged as Indicators of Compromise, Behaviors of Compromise, Enablers of Compromise, and
Analysis.File. Application rules for Endpoint are automatically available on installation of NetWitness
Platform 11.3 and later.

For Endpoint risk score, every Application rule must have an ESA rule that generates alerts used for the
risk score calculation. A set of OOTB ESA rules are available as Endpoint Rule Bundle. Y ou must
specify the Endpoint data sources (Concentrators) and deploy the ESA Rules from the Endpoint Rule
Bundle. For more information, see "Deploy Endpoint Risk Scoring Rules on ESA" section in the ESA
Configuration Guide.

If the Application rule key value matches with ESA rule then an alert is triggered which is used to
compute the risk score and an incident is raised when risk score exceeds the defined threshold limit.

Note: If you are upgrading from an existing Endpoint Log Hybrid to 11.3 or later, you must deploy the
Application rules from RSA Live. During deployment, you must specify Endpoint Log Hybrid Log
Decoder service. In case of multiple Endpoint servers, select all the Endpoint Log Hybrid Log
Decoder services. For more information, see the Live Services Management Guide.

Q
You can view the application rules that are deployed in (Admin) >Services > Endpoint Log
Hybrid - Log Decoder > Config > App Rules and application rules that were triggered in Investigate
> Navigate> Endpoint Log Hybrid - Concentrator > App rules.

The Endpoint ESA rules generate alerts with the severity; Critical, High, and Medium. You can view
the alerts on:

o Risk Details tab - You can view Critical, High and Medium alerts for a host or file on Hosts > Risk
Details or Files > Risk Details.

« Respond view : You can view only critical and high severity alerts on NetWitness Respond >
Alerts.

Custom Endpoint Rule for Risk Scoring

If you have custom IIOCs in NetWitness Endpoint 4.4.0.x, you need to create these custom Endpoint
rules. Once you have created your custom Application rule, you must create the custom ESA Rule for
risk score calculation and update the RiskConfig file in MongoDB.

To create a custom Endpoint rule, perform the following tasks:
1. Add a custom Application Rule

2. Add a custom ESA Rule

3. Add the rule to RiskConfig

15 Deploying Endpoint Application Rules and ESA Correlation Rules
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Add a custom Application Rule

To add a custom application rule:

1. Complete steps 1-11 in "Configure Application Rules" topic of Decoder and Log Decoder
Configuration Guide.

Note: You must be familiar with the metakeys tagged as (Indicators of Compromise, Behaviors of
Compromise, Enablers of Compromise, and Analysis.File) on which an alert will be generated. In
the example below, the alert is generated on Analysis.File metakey for In Encrypted Directory
rule.

Following is an example of an Application Rule created for In Encrypted Directory alert.

Rule Editor

Rule Definition

Rule Name in encrypted directory

Condition device.type = 'nwendpoint' && {dir.path ='encrypted’ | | dir.path.src
='ancryptad’)

Session Data Session Options

| Stop Rule Processing [V Alert [ Forward [ Transient

Alert On analysis.file w

Cancel

2. After a custom application rule is added successfully, select the newly created rule (For example, In
Encrypted Directory alert) and click Apply.

Deploying Endpoint Application Rules and ESA Correlation Rules 16
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General Files Data Retention Scheduler JEGIVEUIIEE Correlation Rules Feeds Parsers Parser Mappings Data Privacy  Appliance Serjd
+ -4 D Disable | 4 Actions Filter X
Status = Pending Name Condition Session Data Alert
intrusion:all-activity (device.class="ips','ids’) && (policy.name exists ... alertid -
executable in ads device.type = 'nwendpoint' && ((category = 'file... analysis.file
powershell double ba...  device.type = 'nwendpoint’ & filename.all = p... analysis.file

outbound from windo...  device.type = 'nwendpoint' && category = ‘net... boc
outbound from unsig...  device.type t' && category = 'net... boc
unsigned opens Isass device.type = 'nwendpoint’ && category = ‘proc... boc
outbound from unsig...  device.type = 'nwendpoint' && category = 'net... boc
rdp launching loopba...  device.type = 'nwendpoint’ && category = ‘proc... boc
autorun invalid signat...  device.type = 'nwendpoint’ && category = 'auto... analysis.file
command shell copyi... device.type = 'nwendpoint’ && OS = 'windows' .. boc

4 jlevice.type = ‘'nwendpoint’ && (dir.path ='e... i’ analysis.file

Apply Revert

Rule Modifications

Existing Rules Rules to be Applied
bending | Name conation session Data Aere status pencing | Name conation session Dta Aere seatus

a ‘nwendpoint’ && category... boc & inencrypted dir...  device.type = ‘nwendpoint’ && (dir.path ='e.. analysis f.

a wendpoint' & category... ioc

adds files devic: = nwendgoint’ &4 category.. ioc
adds firewall rule ‘nwiendpoint’ &4 category.. boe
alloc Gevics wendpoint && 05 ='ma boc

antivirus ‘nwendpoint’ && hoststat... eoc

archiving saftwa.. t &8 categary.. boc

autorun * &2 category... analysis .

autorun file path * &8 05 = lin.. analysis .

autorun key con ' && category... ioc

autorun rpm mi.. t &8 05 = lin.. analysis .

autorun unsigne... * &2 category... analysis .

autorun unsigne...  device.type = nwendpoint’ &2 category... analysisf. -

cancel | Apply.

In case of multiple Endpoint servers, you must create this custom Application rule on every Endpoint
Hybrid Log Decoder service.

Add a custom ESA Rule

To add a custom ESA rule, perform the following.

1.
2.

SSH to the Admin Server.

Create a new JSON file (for example,in encrypted directory.json) with the custom ESA
rule definition in the below format.

{

"id": "In Encrypted Directory","key": "analysis.file",
"value": "in encrypted directory",

"title": "In Encrypted Directory",

"type": "ENDPOINT",

"enabled": true,

17
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"description": "End Point rule for In Encrypted Directory",
"severity": "MEDIUM"

}

The following table describes the fields that define a rule.

s Jovempion

id The name of the ESA Rule. For example, In Encrypted Directory.

key The metakey on which an alert would be generated.
For example, alert is generated on analysis.file metakey for In Encrypted Directory
rule.

value Specify the value. The value must exactly match with the App rule name. For

example, in encrypted directory.

title The name of the alert. For example, In Encrypted Directory.
type Specify the type of rule. For custom endpoint rule, the type must be ENDPOINT.
enabled The status of the rule. Specify true, if the rule should be considered for risk scoring.

description ~ The description of the rule.

severity The severity of the rule; critical, high or medium.

3. To enter shell mode of nw-shell, execute the following command:
nw-shell

4. Connect to ESA correlation-server using the following command:
connect --service correlation-server

5. Login to the ESA correlation-server using the following command:

login

Note: You must provide Administrator credentials.

6. Navigate to the API xpath using the following command:
cd correlation/keyvalue/settings/set
7. Run the API using the following command:

invoke --file <absolute-path-to-rule-definition-file>

Note: You must specify the absolute path to the rule definition file. For example, invoke --
file /root/rule.json

Add the rule to RiskConfig

After you create the custom Application rule and the ESA rule, you must update the RiskConfig in
mongoDB.

Deploying Endpoint Application Rules and ESA Correlation Rules 18
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To update the riskconfig file, perform the following:
1. SSH to Admin Server.

2. Create a JavaScript file (For example, in-encrypteddirectory- rule.js) with the custom
ESA rule definition in the below format.

db.risk rule.insertMany (

[

"name" : "In Encrypted Directory",
"enabled" : true,
"handler" : "Default",
"entities" : {

by

"metas" : {

"File" : [

{

"meta" : "checksum src",
"name" : "filename src",
"weight" : NumberInt (100)
}

1y

"Host" : [

{

"meta" : "agent id",
"name" : "alias host",
"weight" : NumberInt (100)
}

]

by

" class" : "com.rsa.asoc.respond.pipeline.risk.rules.AlertScoringRule"

bl
)
The following table describes the fields that define a rule.

L

name The name of the ESA rule.

19 Deploying Endpoint Application Rules and ESA Correlation Rules



NetWitness Endpoint

ey |emmgw 7

enabled

handler
entities
metas > Files > meta
metas > Files > name

metas > Files >
weight

metas > Host > meta

metas > Host > name
>

metas > Host > weight

_class

The flag to enable or disable risk scoring. Specify true to enable risk
scoring.

The value of this should be Default.

The value of this should be empty.

The metakey for a file for which score should be calculated.
The name of the metakey of the file identity.

By default the weight value is 100.

The metakey for a host for which score should be calculated.

The name of the metakey of the host identity.

By default the weight value is 100.

This is used for internal purpose, do not change.

3. Insert the new rule into the riskconfig file on mongoDB using following command:

mongo respond-server --authenticationDatabase admin -u deploy admin -p
<deploy admin-user-password> in-encrypted-directory-rule.js

4. Confirm if ESA rule is updated successfully in the riskconfig, using following command

mongo respond-server --authenticationDatabase admin -u deploy admin -p
<deploy admin-user-password> --eval "db.risk rule.find({ "name": /.*In
Encrypted Directory.*/i })"

5. Restart the Respond server for the changes to take effect.

service rsa-nw-respond-server restart

After you create a custom Endpoint rule and update the risk configuration file, whenever an event is
generated for the new rule (For example, In Encrypted Directory) an alert will be generated and the risk
score is calculated for the host and file.

Deploying Endpoint Application Rules and ESA Correlation Rules 20



Configuring Metadata Forwarding

To view the metadata, you must enable the metadata forwarding while installing the Endpoint Log
Hybrid. The Endpoint metadata is displayed in the NetWitness Platform Investigate (Navigate and
Events views) similar to Logs and Packets. For information on metadata mappings, see Endpoint
Metadata Mappings.

To configure metadata forwarding:

Q
1. Goto (Admin) > Services.

2. In the Services view, select the Endpoint Server service.

Click 8- and select > View > Config.
Click the General tab.

RSA  investigate

HOSTS  SERVICES  EVENT SOURCES ~ ENDPOINT SOURCES

> W

# ChangeService | endpointloghybrid1 - Endpoint Server | Config ©

[SUSF Data Retention Scheduler ~ Agent Packager ~ Relay Server

Endpoint Meta

-z ® Stop

Address Protobuf ssL Protobuf Port REST 5L REST Port User Name

1 false 50202 false 50102 admin

5. Click + in the toolbar.
The Available Services dialog is displayed.

Available Services
j?’ Mame ~ Address Type
ﬂ endpointloghybridl - Log Decoder Log Decoder

59’ endpointloghybrid2 - Log Decoder . Log Decoder

Cancel

6. Select a Log Decoder service and click OK.
The Add Service dialog is displayed.
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Note: You can add only one Log Decoder service.

Please provide administrator credentials for the
service:

Username

Password

Raw Data L

REST SSL @ L]

REST Port 50102 >

Protobuf SSL@& L

Protobuf Port 50202 °

~

Enter the administrator credentials for authentication.

o0

. (Optional) If you enable Raw Data, a brief summary of the session is forwarded along with the
metadata.

. (Optional) If you have enabled SSL on the REST port in the Log Decoder, select the REST SSL
option. By default, the REST port for non-SSL is 50102 and SSL is 56102.

Ne)

10. Select the Protobuf SSL option to enable SSL on Protobuf. By default, the Protobuf port is 50202.
11. Click Save.

After configuring the metadata forwarding, make sure to:
« Start the capture on the Log Decoder
« Start the aggregation on the Concentrator

o Add the Log Decoder as a service in the Concentrator

Start Metadata Forwarding to the Log Decoder

1. Inthe Endpoint Meta config > General view, select the service.

2. Click ™ strt
The Endpoint Server starts forwarding the metadata to the Log Decoder.
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Stop Metadata Forwarding to the Log Decoder

1. Inthe Endpoint Meta config > General view, select the service.

2. Click ™ see.
The Endpoint Server stops forwarding the metadata to the Log Decoder.

Remove Metadata Forwarding

Note: Make sure you stop the service, before removing the metadata forwarding.

1. Inthe Endpoint Meta config view, select the service.
2. Click -.
3. Click Apply.

Endpoint Metadata Mappings

You can view the default metadata mappings or modify the metadata mappings for endpoints.

JSON Schema for Metadata Mappings

All metadata mappings is configured using the JSON schema. The following is a sample JSON schema:
{

"metaKeyPairs" : [

{

"metaKeyPairsCategory" : "",

"keyPairs" : [
{
"endpointJpath" : "",
"metaName" : "",
"type" : "",
"enabled" : true
by
{
"endpointJpath" : "",
"metaName" : "",
"type" : "V,
"enabled" : true
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]
}

The following APIs are used to view or modify the metadata mappings:
e get-default - Returns the default configurations for the endpoint metadata mappings.
e get-custom - Returns the custom configurations for the endpoint metadata mappings.

e set-custom — Helps customize the endpoint metadata mappings.

View the Metadata Mappings

To view the endpoint metadata mappings:
1. Onthe NW server, run the nw-shell command from the command line.
2. Run the 1ogin command and enter the credentials.

3. Connect to the Endpoint Server using the following command:
connect --host <IP address> --service endpoint-server
4. Run the following commands:

cd endpoint/meta
cd get-default
invoke

The following screen shows the default metadata mappings:
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To disable a default metadata mapping:
Enter the same endpointJpath value and set the enabled parameter to false.

For example, if the endpointJpath is Category and enabled parameter is true, enter the same
endpoint]Jpath and set the enable parameter to false.

Note: Do not modify the metaKeyPairsCategory in the schema; “COMMON”, “COMMON _
MACHINE”, “COMMON_MACHINE FOR EVENTS”.

To change the metadata name or metadata type:

Enter the same endpoint]Jpath value and specify values for the metaName and type.
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Note: The metaName must exist in the table-map.xml of the Log Decoder, index-concentrator.xml or
index-concentrator-custom.xml file of the Concentrator, for the metaName to appear on the Investigate
view.

Add or Modify Metadata Mappings

To add or modify the metadata mappings, run the set-custom API. The metaKeyPairs configuration
provided in the JSON file should match the JSON schema of the default configuration received through
the get-default APL

1. On the NW server, run the nw-shell command from the command line.
2. Run the 1ogin command and enter the credentials.

3. Connect to the Endpoint Server using the following commands:

connect --service endpoint-server

4. Run the following commands:

cd endpoint/meta
cd set-custom
invoke --file <json file>

You can add new metaKeys by adding entries to the file that will be uploaded using the set-custom
API. The following example shows how to add a new metadata mapping:

I NWAPPLIAN 65 /1# nw-shell

T

nvoke ——file Scustom.json

View the Custom Metadata Mappings

To view the custom metadata mappings, run the get-custom API, and then invoke commands.

Note: The get-custom API will return values only if the metadata mappings are modified using the
set-custom APL
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Note: The information in this topic applies to RSA NetWitness® Platform Version 11.3 and later.

The Endpoint agents deployed in your environment may be large in number and geographically
distributed. To efficiently manage and update configurations automatically, agents can be organized into
smaller subsets called Groups.

Groups

Groups can be created based on IP address (IPv4 and IPv6), host names, operating system type, and
operating system description. You can create groups based on your requirements. For example, you can
group all agents running on Windows 2016 Server and IP ranging from 10.40.10.1 to 10.40.10.200. For
more information on creating groups, see Creating Groups and Policies.

Note: All agents that are not part of any group use the default policy settings.

Policies

To manage the behavior of agents in a group, you can apply a set of rules called Policies. The RSA
NetWitness Platform supports three types of policies for endpoints: Agent Endpoint, Agent File Logs,
and Agent Windows Logs policies. The following default policies are available on installation.

Note: RSA recommends that you review these default policies before deploying agents.

o Default Agent Endpoint (EDR) Policy

o Default Windows Log Policy

o Default File Log Policy

You can either assign the default policies to a group, modify the default policy, or create custom policies
based on your organizational requirements.

Note: You cannot edit the default policy for Windows Logs nor for File Logs.

You can do the following through a policy:

o Define the agent mode - Insights or Advanced
« Configure scan schedule and settings

« Configure automatic file download

« Configure endpoint settings, such as which Endpoint server the agents should communicate, port
details, and beacon intervals

« Configure response actions such as blocking

« Configure Windows and File Log collection
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For example, you can create a policy to schedule scan and enable blocking. For more information on
creating policies, see Create an EDR Policy, Create a File Log Policy, or Create a Windows Log Policy.

Group Ranking

When a group is created, a rank is associated with every group based on the creation order. If an agent
belongs to multiple groups, to handle conflicting configurations, you can reorder the groups to change the
ranking, and the policy associated with the highest ranked group takes precedence.

Example 1

A Server group contains 100 hosts with a default Agent Endpoint policy. Amongst these, if 20 hosts
require further investigations, analyst can:

1. Create a temporary group with a static list of these 20 hosts.
2. Create or apply any policy to this group that will not impact any other hosts.

3. Edit the ranking for the new group, moving to the top of the Ranking list (making sure it is above the
existing Server group).

4. After investigation is done, delete this group. The hosts are revalidated and assigned to the
appropriate group based on the ranking.

Example 2

Case 1:

Agent 1 Agent 2 Agent 3

I

|

i

| ..
Groups Policies

|

|

|

|

|

|

|

|

|
Group: Hardware |

Policy: Hardware )

|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
dl
|
|
|
|
|

Group: Software }—f\ Policy: Software )

Not part of any group I ( Policy: Default )

* 81, 52, S3, 54, and S5 represents policy settings, such as run scheduled scan, agent mode, scan settings, response actions, and so on.

Each agent is a part of a unique group that is associated with a policy, where each policy has all settings
S1, S2, S3, S4, and S5 defined. For example, Agent 2 is a part of the group Hardware, where all settings
in the policy Hardware are applicable.
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Case 2:
Agent 1 Agent 2 Agent 3
| : :
T T t
! .
i Grbups | Policies
| ‘ ' N\ oo —
! ‘ ! S1 52 S3 [ S4 [ S5
| | | ) () @) @ @
: | I | I : : :
| | | | | | I
| | | | | | |
| | | 1 1 1 |
i Group: Hardware | . ( Policy: Hardware ) | 1
[ | | AN | |
‘ l : : : 1
| | | I I | |
| | 1 I | I
| | I 1 ! |
|
i Group: Software I T *:‘ C Policy: Software )
| i i i | i
| [ | I I
| | | | | I
| | | | | |
| 1 1 1 1 1
Not part of any group I C Policy: Default )

*S1, 52, S3, 54, and S5 represents policy settings, such as run scheduled scan, agent mode, scan settings, response actions, and so on.

In the policy Hardware, S4 and S5 settings are not defined, and hence the agent 2 inherits settings S4 and
S5 from the default policy.

Case 3:
Agent 1 Agent 2 Agent 3 Agent 4 Agent 5

e i s . »

i | i i i .

l I Groups ! ! Policies

| | | | |

[ | I | | — — — — TN

: ! ! ! ! (s1) (s2 {53}k54]'55

| | l | |

: ; | : : I 1 : I I

| ] | | | I | 1 I

! ! | | | ] I | | |

: | 1 I | : | I : : |

! ‘ Group: Hardware — Rank 1 | i Policy: Hardware ) | ! |
|

: . : : I : : :

: 1 | | I. : : |

! ‘ Group: Software — Rank 2 I i " 8 ! Policy: Software
I

i : : ! : : ! : :

! I I I ! ! ! | |

! ‘ Group: Engineering — Rank 3 i {_Policy: Engineering ) ! |

| | i | | |

| | I | | |

L 1 1 1 1 1

Not part of any group I ( Policy: Default )

* 81, 82, 53, S4, and S5 represents policy settings, such as run scheduled scan, agent mode, scan settings, response actions, and so on.

o Agent 2 is a part of the highest ranked group Hardware, and with the policy Hardware. The agent 2
inherits settings S3, S4, and S5 from the default policy as they are not defined in the policy Hardware.
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o Agent 3 is a part of Hardware, Software, and Engineering groups, and with the policy Software. The

agent considers the settings S4 and S5 from the policy Software, and the remaining undefined settings
are inherited as follows:

o S1 and S2 from the policy Hardware, which is associated with the highest ranked group.
o S3 from the policy Engineering, which is the next ranked group.

o Agent 4 is a part of Hardware, Software, and Engineering groups, and with the policy Engineering.

o Though settings S1 and S2 are defined in policy Engineering, the agent 4 considers the settings S1
and S2 from the policy Hardware as it is associated with the highest ranked group.

o S4 and S5 from the policy Software, which is the associated with the next highest ranked group.
o S3 from the policy Engineering.

The following are some of the key points:

If an agent is not assigned to any group, default policies are applied.

A policy can be assigned to multiple groups. However, a group can only have one policy of each type
(Agent Endpoint and Agent Windows Logs).

An agent can belong to multiple groups. The policy is derived based on the ranking of the group as
shown in the above example (case 3).

If all settings are defined in a single policy, and it is the highest ranked policy for an agent, no policy
settings from other ranked groups are inherited (case 1).

If there are any undefined settings in the policy, the settings from the default policy is considered as
shown in the example above (case 2 and 3).

If an agent falls into more than one group, its complete set of policy attributes is determined as
follows:

« It takes all settings from the highest ranked policy that applies.

« Any settings that are not set in the highest ranked policy are taken from the next highest ranked
policy that applies.

« If there are still unset attributes, they are taken from the default policy.

« If there are any conflicts, the higher ranked policy wins.

Example 3

Assume the following:

Agent A belongs to below two groups, Production Servers and All Windows Hosts.

The Production Servers group has the Schedule scan set and no blocking policy assigned, and it has
the following settings:

e Schedule Scan : Enabled
o Effective Date: 2019-03-08
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o Start Time: 09:00

e Scan Frequency: Every 1 week

o CPU Maximum: 45 %

o Virtual Machine Maximum: 20 %

« Blocking: Disabled

The All Windows Hosts group has the EDR for All Windows policy applied, which has the
following settings:

o Scan Master Boot Record: Disabled
« Blocking: Enabled

The Production Servers group is ranked higher than the All Windows Hosts group for EDR policies.
Keep in mind that ranking only applies to policies of the same source type: that is, all EDR policies
are ranked, and all Windows Logs policies are ranked separately.

Agent A gets its final policy configuration as per the ranking of the groups (and associated policies) to
which it belongs:

D

The agent uses the schedule set in the Schedule scan set and no blocking policy.

Scan Master Boot Record is disabled, because that is set in the EDR for All Windows policy.
Blocking is disabled: since there is a conflict, the value in the higher ranked policy is used.
All other attributes are set based on values in the Default EDR policy.

Note that if you wanted Blocking to be enabled, you could change the group ranking so that All
Windows Hosts is higher than Production Servers: in this case, Production Servers would win the
conflict, and Blocking would be enabled for Agent A.

efault Agent Endpoint (EDR) Policy

When an agent is installed, it operates in an Insights mode until a policy is assigned. The following are
the default EDR policy settings:

Scan Schedule Run Scheduled Scan Disabled

Effective Date Current date

Scan Frequency Every week

Start Time 09:00 (this is 9 AM)
CPU Maximum 25%

Virtual Machine 10%

Maximum
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Agent Mode Monitoring mode Advanced
Scan Settings ~ Scan Master Boot Disabled
Record
Auto Scan New Disabled
Systems When Added
File Download Automatic File Enabled
Settings Download
Signature Exclude All Signed
File Size Limit 1 MB
Response Blocking Disabled
Action Settings
Network Isolation Disabled
Endpoint Endpoint Server The agent considers the default Endpoint Server that is
Server Settings configured during packager generation.

Server Alias (Optional)

HTTPS Port 443
HTTPS Beacon Interval 15 Minutes
UDP Port 444

UDP Beacon Interval 30 Seconds

Default Windows Log Policy

The following are the default Windows Log policy settings:

Windows Log Settings Status Disabled
Protocol TLS
Send Test Log Disabled

Default File Log Policy

The following are the default File Log policy settings:

Endpoint Sources
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File Log Settings Status Disabled

Protocol TLS
Send Test Log Disabled
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Creating Groups and Policies

Note: The information in this topic applies to RSA NetWitness® Platform Version 11.3 and later.

The following sections provide instructions on how to create groups and policies.

o Groups: Create a Group
« Policies:

o Construct a Policy

e Create an EDR Policy

o Create a Windows Log Policy

Create a File Log Policy

Replace Windows SFTP Agents

Create a Group

To create a group:

QA
1. Goto (Admin) > Endpoint Sources view.
2. In the left panel, select the Groups tab.

Dashboards
ENDPOINT SOURCES HEALTH & WE
GROUPS  POLICIES
-+ Create New Edit Ranking
GROUP NAME 1+ SOURCE CO.. POLICIES APPLIED ‘GROUP DESCRIPTION
Aled. 1 AlexEDR, AlexFileLogs1

Aee Alexogs2

1
ASIA Servers 1 Serverswith Encoding
1

Etienne's EDR v/, Etienne’s File Polic.

Test group creation

Showing 5 out of 5 items | Oselected

3. In the toolbar, click Create New.

4. In the New Group panel, enter a group name and group description, and

POLICY TYPES APPLIED PUBLICATION STATUS
Agent Endpoint, Agent Fil.  Published
Agent File Logs Published
Agent File Logs Published

Agent Endpoint, Agent Fil.  Published

click Next.
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RSA nvestig: Users Hosts Files

EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS

HOSTS SERVICES SYSTEM SECURITY

GROUPS POLICIES

< NEW GROUP

GROUP DESCRIPTION

Cancel

5. Specify the logical statements that define the condition for an agent to be included in the group. Each
logical statement consists of: parameter, operator, and values to match.

RSA Y U H. Files D

ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

HOSTS SERVICES EVENT SOURCES

GROUPS POLICIES

o
& )
= U Include sourceif  all of the following conditions are met:

Group for test

between

Apply Policies

Add Condition

Next Save and Close Publish Now

o In the Include source if ___ of the conditions are met ficld, select either all or any.

o For each logical statement, select the required options:
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e |

Parameter The parameter can be OS Type, OS Description, Host Name, IPv4, or IPv6.

e OS Type, OS Description, Host Name: The value you enter should reference hardware or
virtual machines that are running endpoint agents.

o IPv4 or IPv6: Enter valid IP addresses as either ranges or as a set of IP addresses to
include or exclude.

Note: If you do not want to include certain IP addresses, use the Not in operator, and enter the IP
addresses separated by a space or a comma.

Operator The choice of values is dependent upon the parameter you chose. For example, if your
parameter is OS Type, the only operator available is in.

Value or The value or values to match. For the OS Type parameter, you can choose one or more

values to values from the drop-down list. For all other parameters, you can enter free-form text.

match

Note: Although you can enter any text for values, the system validates your entries when you attempt
to proceed to another screen, and will not allow you to proceed until values are valid.

6. Continue adding conditions until you have completely specified the new group. After you have added
all conditions, click Next to proceed.

7. (Optional) Click Apply Policies and select the source type from the drop-down list.

Policies with the selected source type are displayed below Available Policies.

[
Select a policy by clicking . Skip this step if you want to apply a policy to the group at a later
time.

RSA
HOSTS  SERVICES N CES SYSTEM  SECURITY

GroUPS

ESTGROUP Agroup does not need to apply a policy, however, for a policy to be active, it must be applied to a group.

If this step is skipped, policies can still be applied to this group later.

®

Choose a Policy Type

Available Policies Selected Policy

POLICY NAME APPLIED TO GROUPS POLICY DESCRIPTION POLICY NAME APPLIED TO GROUPS POLICY DESCRIPTION

Previous Save and Close Publish Now Cancel

Note: You can attach only one policy per source type to a group. That is, you cannot attach more
than one Agent Endpoint policy to a single group, nor more than one Agent Windows Logs policy.

For more information on creating policies, see Create an EDR Policy, Create a Windows Log Policy,
or Create a File Log Policy.

8. Do one of the following:
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« Click Save and Close to save the settings and return to the Groups view. The publication status is
displayed as Unpublished in the Groups view.

Note: You can select an unpublished group and click Publish to publish a group.

o Click Publish Now to publish the group.

Construct a Policy

When you create a policy, you should keep in mind the way groups and Agents can inherit values from

other policies. The simplest way to construct a policy is to set values for all of the available settings for
that policy type. If you do this, you can assign the policy to one or more groups, and all of the agents in

those groups can receive the settings defined in the policy itself.

However, you do not need to set all possible available settings within a single policy. In the Group
Ranking section, there are examples that show where values can come from, based on the ranking order.

Note: Remember that a group can have no more than one of each policy type assigned to it: it can be
assigned 0 or 1 Agent Endpoint, Agent File Logs, and Agent Windows Logs policies.

If an agent is only a member of one group, that agent's settings are as follows:
o If a value is set in the policy assigned to the group, that value is used.

o Ifa value is not set in the policy assigned to the group, the value set in the default policy is used.

For agents that are members of multiple groups, it is a bit more complicated. For these agents, the
settings are evaluated from highest priority member group (as set on the Edit Rankings page) to the
lowest priority member group. If a parameter is set in a higher group, it is not overwritten, event if the
same parameter is also set in a lower group. For example, assume an Agent is part of three groups:

o Ifavalue is set in the highest ranked policy, the agent uses that value.

o Ifa value is not set in the highest ranked policy, but is set in the second-highest-ranked policy, the
agent uses the value from the second-highest-ranked policy.

o Ifa value is not set in either the first- or second-highest ranked policy, but is set in the third-highest-
ranked policy, the agent uses the value from the third-highest-ranked policy.

o If a value is set in the highest-ranked policy and either or both of the other policies, the value is taken
from the highest-ranked policy.

o Ifa value is not set in any of the three policies assigned to the agent, the agent uses the value set in
the default policy.

Create an EDR Policy

While creating a policy, note the following:
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o Whenever you choose a setting, it is added to the Selected Settings panel.

o To clear any of your selected settings, click m to remove that setting.

o At any point in the wizard, you can choose Save and Close, so that you can return to complete the
policy at a later time.

To create an EDR policy:

A
1. Goto (Admin) > Endpoint Sources.
2. Click Policies. The available policies are displayed.

EVEN S ENDPOINT SOURCES  HEALTH & W

GROUPS  POLICIES
+ Create New

[] POLICY NAME +  APPLIED TO GROUPS POLICY DESCRIPTION POLICY TYPE PUBLICATION ST

[0 CiscoEventSources File Log policy for all Ciscod...  AgentFile Logs Published

[0  Default EDR Policy € These are the settings thata_.  Agent Endpoint Published

Default File Policy These arethesettingsthata . AgentFile Logs Published

Default Windows L. These are the settings thata.. AgentWindowslogs  Published
O Unpublished

O Unpublished Edits EDRAmericas EDR policy for the Americas  Agent Endpoint

Showing 5out of 5 items | Oselected

3. Click Create New to add a new policy.

4. Inthe New Policy panel, do the following:
RSA Investigate 3 nd Users osts Files % @ admin >
HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

GROUPS POLICIES

B TEST EDR POLICY POLICY TYPE

Test anew EDR Policy

Agent Endpoint

POLICY NAME

Define Policy Test EDR Policy

POLICY DESCRIPTION

Test anew EDR Policy
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o Select Agent Endpoint as the source type from the drop-down list.
« Enter the policy name.
o Enter a description for the policy.

Click Next.

I(_‘I‘I
6. Click Bl to select a setting from list of Available Settings. After you click, the specific setting is
moved under the Selected Settings panel. You need to enter the required values for the selected

settings. For details, see Define Policy Panel for Agent Endpoint Policy.

Note: You do not need to set all possible available settings within a single policy. The complete
list of settings for an agent is derived from one or more groups to which that agent belongs. This is
described in more detail in Construct a Policy.

Available Settings Selected Settings

Scan Schedule Agent Mode

Run Scheduled Scan

Endpoint Server Settings

1 Minutes

Download Settings O L

File Downloads
Seconds

Previous ‘ Save and Close Publish Policy Cancel

o Inthe Scan Schedule category, enable Run Scheduled Scan to configure the scan, and set any of
the available parameters based on your needs. For more details, see Define Policy Panel for

Agent Endpoint Policy.

o Inthe Agent Mode category, you can set the following:
« Select the monitoring mode of the agent - Insights or Advanced.

o Select Expanded Network Visibility:

Prerequisite

Note: For Expanded Network Visibility to work, ensure the service user account used for
aggregating Endpoint Log Decoder data to Endpoint Concentrator is assigned with the
decoder .manage permission. For more information on how to assign roles and permissions,
see "Services Security View - Aggregation Role" in the Hosts and Services Getting Started

Guide for RSA NetWitness Platform.

« To enable network tracking and monitoring on Windows hosts in Insights mode.
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Note: Reports UDP connections for Windows 10 version 1803 in Insights mode.

« To optimize the frequency of agents sending network events for both Insights and Advanced
modes.

o The endpoint agents should have the Expanded Network Visibility option enabled for
enriched network events from NetWitness Platform packet deployment with endpoint data.
In the Events View > Hosts tab, the endpoint data related to the network event selected will
be automatically displayed if it exists. For more information, see "Host Information" in the
Investigate User Guide.

Note: For network tracking in Insights mode, verify that the Windows Management
Instrumentation (WMI) service is enabled.

o Inthe Scan Settings category, you can enable either or both of the following actions:

o Enable Scan Master Boot Record to include Master Boot Record (MBR) details in scheduled
scans.

« Enable Auto Scan New Systems When Added to automatically queue a scan for any host that
does not have any snapshot data

o In the Download Settings category, you can set the following:

o Enable Automatic File Downloads to automatically download files based on the Signature and
file size. By default this option is enabled.

« Select the Signature type to limit the download of files based on the signature (not available
for Linux systems).

o Specify the File Size Limit to limit the download of files based on the file size. The file size
limit should be between 1 KB - 10 MB.

« Inthe Response Action Settings category you can enable or disable the following actions:
« Enable Blocking to prevent the execution of a malicious file on any host.

o Enable Network Isolation to provide an option to isolate a compromised host during
investigation.

« In the Endpoint Server Settings, configure your server:

o Add the Endpoint server that the agent will communicate from the drop-down list.

Note: If you do not select an Endpoint Server, the agent uses the default Endpoint Server that
is configured during packager generation.

o (Optional) Enter an alternative hostname or IP address.

« Enter the HTTPS port used for communication.
o Specify the HTTPS beacon interval.
o Enter the UDP port used for communication.

o Specify the UDP beacon interval.
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o Advanced Setting - For RSA Support staff only.

IMPORTANT: It is strongly recommended not to use the Advanced Configuration unless
advised to do so by RSA.

7. Do one of the following:

« Click Save and Close to save the settings and return to the Policies view. The policy will be listed
under the Unpublished category.

« Click Publish Policy to publish the policy.

Create a Windows Log Policy

To create a Windows Log policy:

Q
1. Goto (Admin) > Endpoint Sources.
. Click Policies. The available policies are displayed.

2
3. Click Create New to add a new policy.
4. Inthe New Policy panel, do the following:

RS A stigate X d L Hosts Files Das

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

GROUPS POLICIES

TEST POLICY POLICY TYPE

Test policy for windows log Agent Windows Logs

POLICY NAME

Test Policy

POLICY DESCRIPTION

Test policy

o Select Agent Windows Logs as the source type from the drop-down list.
« Enter the policy name.
o Enter a description for the policy.

5. Click Next.
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I(_\
6. Click to select a setting from list of Available Settings. After you click a setting it is moved
under the Selected Settings panel. You need to enter the required values for the selected settings.

Note: You do not need to set all possible available settings within a single policy. The complete
list of settings for an agent is derived from one or more groups to which that agent belongs. This is
described in more detail in Construct a Policy.

RSA vestigate Respon Users osts  Files  Dashboards  Report:

HOSTS ~ SERVICES ~ EVENT SOURCES  ENDPOINT SOURCES  HEALTH & WELLNESS ~ SYSTEM  SECURITY
GROUPS POLICIES

B TEST POLICY

Available Settings ® Selected Settings

Test policy for EP

Identify Policy Windows Connection Settings Windows Connection Settings
Send Test Log

Primary Log Decoder / Log Collector

Secondary Log Decoder / Log Collector (@ O Enabled

Protocol
Channel Filter Settings
Advanced Configuration L R
Throttle Network Bandwidth €@ CHANNEL NAME FILTER EVENT ID

Advanced Setting
System INCLUD... ALL

Save and Close Publish Policy

o Select Windows Log Collection to enable Windows Log collection. By default, this option is
disabled.

o Enable Send Test Log to send a test log. By default, this option is disabled.

o Select Primary Log Decoder / Log collector to forward logs from the drop-down list.

o (Optional) Select Secondary Log Decoder / Log collector to forward logs from the drop-down
list.

Note: When the Endpoint Agent is configured to use the UDP protocol and the Primary Log
Decoder/ Remote Log Collector is not reachable, the secondary Log Decoder or Log Collector
is not functional. The logs are not forwarded to the secondary Log Decoder or Log Collector
when the primary is down, thus resulting in the event loss.

o Select Protocol from the drop-down list. The available options are UDP, TCP, and TLS. By
default, the protocol is TLS.

o Add Channel Filters and select the channels from which the logs are collected from the drop-
down list. You can add or remove a channel filter and specify individual Event IDs.
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e Advanced Configuration

o Throttle Network Bandwidth: use this setting to limit network bandwidth that the Agent uses
to connect to NetWitness Platform. This setting is disabled by default: click Enabled to turn it
on, and then enter a value in kilobits per second.

o If not set, Agent does not do any network throttling.

« If set to a positive value x, agent limits network bandwidth to x kbps.

o Advanced Setting - For RSA Support staff only.

IMPORTANT: It is strongly recommended not to use the Advanced Configuration unless
advised to do so by RSA.

7. Do one of the following:

o Click Save and Close to save the settings and return to the Policies view. The policy will be listed
under the Unpublished category.

o Click Publish Policy to publish the policy.

Create a File Log Policy

Note: You cannot create File Log policies while the system is in mixed mode. Until all Endpoint
servers are updated to 11.4, the Agent File Logs options on the policy create, assign policy, and edit
ranking pages are disabled.

To create a File Log policy:

Q
1. Goto (Admin) > Endpoint Sources.

. Click Policies. The available policies are displayed.

2
3. Click Create New to add a new policy.
4. Inthe New Policy panel, do the following:
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RSA ' G J Hosts Files

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

GROUPS POLICIES

&I TEST POLICY POLICY TYPE

File policy for test Agent File Logs

POLICY NAME

Test Policy

POLICY DESCRIPTION

File policy for test

o Select Agent File Logs as the source type from the drop-down list.
« Enter the policy name.
o Enter a description for the policy.
5. Click Next.
6. Click to select a setting from list of Available Settings. After you click a setting, the specific

setting is moved under the Selected Settings panel. You need to enter the required values for the
selected settings.

Note: You do not need to set all possible available settings within a single policy. The complete
list of settings for an agent is derived from one or more groups to which that agent belongs. This is
described in more detail in Construct a Policy.

RSA  Investg s Hosts Files Da
HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

GROUPS POLICIES

B TEST POLICY . . )
Available Settings @ Selected Settings ©

Endpoi

File Connection Settings
Collect File Logs
Send Test Log

Primary Decoder / Log Collector

Secondary Log Decoder / Log Collector

Protocol

Advanced Configuration

Throttle Network Bandwidth

Advanced Setting
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« Enable Collect File Logs to collect file logs on endpoints assigned to this policy. By default, this
option is disabled.

o Enable Send Test Log to send a test log. By default, this option is disabled.

o Select Primary Log Decoder / Log collector to forward file logs from the drop-down list.

o (Optional) Select Secondary Log Decoder / Log collector to forward file logs from the drop-
down list.

Note: When the Endpoint Agent is configured to use the UDP protocol and the Primary Log
Decoder/Remote Log Collector is not reachable, the secondary Log Decoder or Log Collector is
not functional. The logs are not forwarded to the secondary Log Decoder or Log Collector when
the primary is down, thus resulting in the event loss.

« Select Protocol from the drop-down list. The available options are UDP, TCP, and TLS. By
default, the protocol is TCP.

o Advanced Configuration

o Throttle Network Bandwidth: use this setting to limit network bandwidth that the Agent uses
to connect to NetWitness Platform. This setting is disabled by default: click Enabled to turn it
on, and then enter a value in kilobits per second.

o If not set, Agent does not do any network throttling.

« If set to a positive value x, agent limits network bandwidth to x kbps.

o Advanced Setting - For RSA Support staff only.

IMPORTANT: It is strongly recommended not to use the Advanced Configuration unless
advised to do so by RSA.

7. Click Next, and add the file type or types for the policy.

a. Select a log file type from the list, then click Add Selected File Type to configure its log
collection settings.

RSA nvestigate ond Sers osts Dasl

HOSTS SER 5 SOURCES ENDPOINT SOURCES HEALTH & W 55 SYSTEM SECURITY

GROUPS POLICIES

ETESTPO

File Policy Settings

Select an application log file type from the list of supported file types to configure its log collection settings

Need help integrating the available File Types with NetWitness Platform? Check out Event Source
Integration Guides

LOG FILE TYPE

For a list of currently supported event source types, see Endpoint Sources - Policies.

b. Choose values for the available parameters.
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S ENDPOINT SOURCES ~ HEALTH & WELLNESS  SYSTEM

LOG FILE TYPE
CiscoWorks
COLLECT LOGS

LOG FILE PATH
CA\Pr \CSCOpPAMDC\

EXCLUSION FILTERS

Save and Close Publish Policy Cancel

o Collect Logs: Select Enable or Disable.

o On First Connect: Choose whether or not to collect older, historical data, or just new data.
The default setting is to collect new data only.

Note: New data is data that is collected starting from when you configure log collection for
the specified event source.

o (Optional) Log File Path: Add a path for where the log files are stored. This is only necessary
if the log files are not stored in the standard directory for the selected event source type. To
add a path, click Add Path and enter a pathname.

Note: This can be a Universal Naming Convention (UNC) pathname.
(\\host-name\share-name\file-path).

Click Add Path again to add another path. You can add as many paths as you like.

o Exclusion Filters: You can enter a newline-separated list of exclusion filters, which specify
log files from which RSA should not be collecting data.

Note: The filter needs to be entered as a valid regex string, or the system will not allow you
to save it.

o Advanced Settings: note that most users do not need to set these parameters.

o Source Alias: For most installations, this value is not needed. Use this to specify a unique
event source name, in the case you have multiple event sources of the same type, for
example two IBM WebSphere MQ event sources in the same NetWitness Platform
installation.

« File Encoding: Select a type of file encoding. You can choose from a wide variety of
encodings. The default value is UTF-8/ASCII.

For more details on the available parameters, see Panels for Log File Policy.
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¢. You can add more file types to the policy. After you have added all your file types, proceed to the
next step.

8. Do one of the following:

o Click Save and Close to save the settings and return to the Policies view. The policy will be listed
under the Unpublished category.

« Click Publish Policy to publish the policy.

Replace Windows SFTP Agents

Note that you might want to replace the SFTP Agent for Windows with the NetWitness Platform
Endpoint Agent for collection from file event sources. If so, perform the following procedure:

1. Using the File Collection Policy wizard (as described below), configure file collection for your event
sources.

2. Verify that collection is working.

3. On each of your event sources, stop the SFTP service.
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Note: The information in this topic applies to RSA NetWitness® Platform Version 11.3 and later.

You can view group details, edit group details, filter endpoint groups, delete groups, and edit group
ranking. For details on how to create groups, see Create a Group.

View Group Details

To view properties of the selected group:

Q
1. Goto (Admin) > Endpoint Sources.

2. In the left panel, select the Groups tab. The details, such as group name, source count, policies
applied, group descriptions, source type applied, and publication status are displayed. For more
details on these columns, see Endpoint Sources - Groups.

3. Click the row to view the properties in the right-panel.

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

GROUPS POLICIES

-+ Create New Edit Ranking Edit Delete
ASIAServers

GROUP NAME + SOURC... POLICIES APPLIED GROUP DESCRIPTION POLICY TYPE... PUBLICATION...

- 5 Servers fromasia
Alex 1 AlexEDR, AlexFileLogs1 Agent Endpoint,.  Published
Ao 1 Alexogs? Agent File Logs Published
ASIA Servers 1 Servers with Encoding 0 Agent File Logs Published
2 Servers with Encoding

Etienne's EDR v/, Etienn... Agent Endpoint, ...

Test group creation

winagentPriya

2019-10-1501:04
admin
2019-10-1504:15
admin

2019-10-1504:15
Showing 5 out of S5items | 1selected

Filter Endpoint Groups

The Filters Panel allows you to filter the list of displayed groups, based on the one of the following
source type:

« Agent Endpoint
o Agent Windows Logs

Additionally, you can sort based on publication status:
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« Published - Groups that are published to use.

o Unpublished - Groups that are saved but not published.

o Unpublished Edits - Groups that are previously published and edited later and saved, but not
published.

GROUPS POLICIES

The Filters panel can be hidden or displayed:
e To hide, click the B icon at the top-right of the panel.

o To display if hidden, click the icon in the toolbar.

Click Reset Filters to remove the currently applied filter criteria.

Edit a Group

You can edit the properties of the group at any point in time. To edit properties of a group:

QA
1. Goto (Admin) > Endpoint Sources.
2. Select a group and click Edit.
3. Edit the group details as required.
4. Do one of the following:

o Click Save and Close to save the changes and return to the Groups view. The group will be listed
under the Unpublished Edits category.

o Click Publish Now to publish the changes.

Delete a Group

To delete a group:
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4
I. Goto (Admin) > Endpoint Sources.
2. The Groups tab and available groups are displayed.

T SOURCES HEALTH & WELLNESS SYSTEM SECURITY

+ CreateNew || Edit Ranking & Publish || Edit || Delete |

GROUP NAME 1 SOURCE _ POLICIES APPLIED GROUP DESCRIPTION
1 AlexEDR, AlexFileLogs1
Alexd ogs2
Servers with Encoding
Etienne’s Group '+ Etienne’s EDR v, Etienne’s Fi...

ScooM Groupl

3. Select one or more groups and click Delete.

4. Click Delete. The confirmation message is displayed.

POLICY TYPESA_  PUBLICATION ST_
Agent Endpoint, Age..  Published
Agent File Logs Published
Agent File Logs Published

Agent Endpoint, Age...  Published

5. Inthe Delete Groups dialog, click Delete Group(s) to permanently delete the selected groups.
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Note: The information in this topic applies to RSA NetWitness® Platform Version 11.3 and later.

You can view, edit, filter, and delete policies, as detailed in the following sections:

o View Policy Details

o Filter Policies

« Edit a Policy
o Delete a Policy

o Conflict Resolution

View Policy Details

To view properties of the selected policy:

Q
I. Goto (Admin) > Endpoint Sources.

2. In the left panel, select the Policies tab. The details, such as policy name, applied to groups, policy
description, source type, and publication status are displayed. For more details on these columns, see
Endpoint Sources - Policies.

3. Click the row to view details about selected policy in right pane.
RSA i Users  Hosts

ENDPOINT SOURCES

GROUPS POLICIES

-+ Create New & Publish Edit [ Delete

EDR Americas
[ POLICY NAME + APPLIED TO GROUPS POLICY DESCRIPTION POLICY TYPE PUBLICATION ST

) EDR policy for the Americas
[0 CiscoEvent Sources File Logpolicy forall Ciscod...  Agent File Logs Published

0 Default EDR Policy These are the settingsthata . Agent Endpoint Published

Default File Policy These are the settingsthata . Agent File Logs Published
Enabled

Default WindowsL .. These are the settingsthata .  AgentWindowsLogs  Published Every 1 week(s) on Monday
12%

2019-12-1612:48
admin
2019-12-1601:44
admin
2019-12-1612:48

Showing 5 outof 5items | 1selected

Filter Policies

The Filters Panel allows you to filter the list of displayed policies, based on the source type. You can
filter on any combination of the following:
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o Agent Endpoint
o Agent File Logs
o Agent Windows Logs

Additionally, you can filter based on publication status:

o Published: Policies that are published to use.

« Unpublished: Policies that are saved but not published.

« Unpublished Edits: Policies that are previously published and edited later and saved, but not published.

Policies

Agent Log Files

YBLICATION STATUS
Published
Unpublished

Unpublished Edits

The Filters panel can be hidden or displayed:

e To hide, click the B icon at the top-right of the panel.
o To display if hidden, click the icon in the toolbar.

Click Reset Filters to remove the currently applied filtering criteria.

Edit a Policy

You can edit the settings of the default Agent Endpoint and custom policies. The default Agent Windows
Log policy cannot be edited.

Note: For the default EDR policy, you cannot edit the source type, policy name, and policy
description. However, you can edit the details in the Define Policy panel.
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To edit a policy:

1. Goto K&l (Admin) > Endpoint Sources, and select the Policies tab.
2. Select a policy and click Edit.

HOSTS SERVICES EVENT SOURCES

GROUPS POLICIES

ENDPOINT SOURCES HEALTH & WELLNESS SYST

EM SECURITY

+ CreateNew | | [ & Publish || Edit || Delete

D POLICY NAME 1+ APPLIED TO GROUPS
[0 CiscoEvent Sources
O Default EDR Policy

Default File Policy

Default Windows

EDRAmericas

3. Edit the policy details as required.

4. Do one of the following:

POLICY DESCRIPTION

File Log policy for all Cisc...

These arethe settingstha...
These are the settingstha .
These are the settingstha

EDR policy for the Americ...

POLICY TYPE
Agent File Logs
Agent Endpoint

Agent File Logs

Agent Windows L.

Agent Endpoint

Showing 5 outof 5items | 1selected

PUBLICATION _

« Click Save and Close to save the changes and return to the Policies view. The policy will be
listed under the Unpublished Edits category.

« Click Publish Policy to publish the changes.

Delete a Policy

To delete a policy:

4
1. Goto (Admin) > Endpoint Sources.
2. Click the Policy tab. The available policies are displayed.
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RSA  investist

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

GROUPS POLICIES

% | + CreateNew | | [ o Publish || Edit || Delete

D POLICY NAME + APPLIED TO GROUPS POLICY DESCRIPTION POLICY TYPE PUBLICATION _.
[0 CiscoEventSources File Logpolicyforall Gisc..  Agent File Logs
[0 Default EDR Policy Y These arethesettingstha . Agent Endpoint

Default File Policy These arethe settingstha . Agent File Logs

Default Windows .. These arethe settingstha.. Agent Windows L.

EDR Americas EDR policy for the Americ.  Agent Endpoint

Showing 5 out of 5 items | 1 selected

3. Select one or more policies and click Delete.

The confirmation message is displayed.

4. In the Delete Policies dialog, click Delete Policy(ies) to permanently delete the selected policies.

Conflict Resolution

An endpoint can be in more than one group, and can thus have more than one Agent Endpoint, Agent File
Logs, or Windows Logs policy applied to it. In this case, there may be conflicting settings that could be
applied to the endpoint.

For example, an endpoint that is in two Groups could have two, different File Log policies applied to it.
In this case, some of the settings could have conflicting values. The value that is actually applied to the
endpoint is determined by the highest-ranked policy that contains a value for that setting.

For example, assume there is an endpoint that has 2 Agent File Log policies applied to it:
o LF Policy One: Log File Type is webgateway, and File Encoding is set to UTF-8
o LF Policy Two: Log File Type is webgateway, and File Encoding is set to Local Encoding

How NetWitness Platform assumes the webgateway logs are encoded is dependent upon which policy is
ranked higher:

« If Policy One is ranked higher than Policy Two, NetWitness Platform treats the logs as having UTF-8
encoding.

o If Policy Two is ranked higher than Policy One, NetWitness Platform treats the logs as having Local
Encoding.

For an example using EDR policies, see Simulation Examples, which shows how you can preview the
settings that would be applied before actually changing any policy rankings.
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An endpoint agent can be included in multiple groups. And these groups can have different policies
applied to them. In this case, you can edit the ordering or ranking of policies, to specify a hierarchy for
your policies.

Edit Ranking

To edit the ordering or ranking of a group:

QA
I. Goto (Admin) > Endpoint Sources.
2. Select the Groups tab and click Edit Ranking.

3. Select one of the following source type for the drop-down list:
« Agent Endpoint to rank the groups associated with Agent Endpoint type policies.
o Agent Windows Logs to rank the groups associated with Agent Windows Log type policies

o Agent Log Files to rank the groups associated with agents that are using File Collection.

Files Dashboards
HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

GROUPS  POLICIES

<% RANKING GROUPS
Ranking is established per Policy Type. Select a Policy Type to continue.

POLICY TYPE

AGENT ENDPOINT

Agent Endpoint
Agent File Logs
Agent Windows L...

Cancel

4. Click Next.
The Ranking view is displayed:
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Dasl

ENDPOINT SOURCES ~ HEALTH & WE

POLICY TYPE: Agent Endpoint ©@ SIMULATED SOURCE SETTINGS ©

SIMULATE  GROUP NAME POLICY APPLIED
Disabled
Alex1 AlexEDR 1
ScooM Group1 Scott Test EDR Updating

Etienne's Group “+ Etienne’s EDR v/ 1

Advanced

Disabled
Disabled

2 Disabled

As Per Packager
443

15 Minutes

444

30 Seconds

Previous

GOVERNING POLICY - GROUP

Default EDR Policy - None

Default EDR Policy - None

Default EDR Policy - None
Default EDR Policy - None

Default EDR Policy - None

Default EDR Policy - None
Default EDR Policy - None
Default EDR Policy - None
Default EDR Policy - None
Default EDR Policy - None

You can simulate your policy settings and how they affect the endpoints within their groups. This
gives you the ability to preview how your changes to the ranking will affect the policy settings

applied to each hypothetical agent.

5. You can manipulate the sliders to simulate different options. You can select the slider in the
Simulate column for each group into which a hypothetical agent would fall, and drag it to the right to

simulate turning on that policy.

This image shows all policies being simulated:
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ENDPOINT SOURCES ~ HEALTH & WELLNESS ~ SYSTEM  SEC

POLICY TYPE: Agent Endpoint ©® SIMULATED SOURCE SETTINGS ©

Set Top Ranking
SETTING GOVERNING POLICY - GROUP

SIMULATE ‘GROUP NAME POLICY APPLIED

Enabled Scott Test EDR - ScooM Group1
09:00 Scott Test EDR - ScooM Group1
Alex1 AlexEDR Every 1weekfs) ~Default EDR Policy - None
on Monday
ScooM Group1 Scott Test EDR 25% Default EDR Policy - None

18% Scott Test EDR - ScooM Group1
Etienne's Group + Etienne's EDR v/

Insights AlexEDR - Alex1

Disabled Default EDR Policy - None
Disabled Default EDR Policy - None

Scott Test EDR - ScooM Group1

EPS1-Endpoint AlexEDR - Alex1
Server

443 Default EDR Policy - None
15 Minutes Default EDR Policy - None
444 Default EDR Policy - None
4 Camnndn AlmEnn Alea

Previous Cancel

6. Reorder your groups as necessary.
a. Select anywhere within a group's row.
b. Drag the group up or down to change the priority. Priority decreases from top to bottom.

c. Repeat moving groups until they are ordered as you prefer.

Note: To move any group to the top, select the group and click Set Top Ranking.

7. As you change the rankings for your groups, you can preview how the policy settings would change
based on your new rankings. For example, assume each of the following scenarios:

« If you have a hypothetical agent that belongs in group 1, simulate only group 1 to see which
policies would affect that agent.

« If you have a hypothetical agent that belongs in group 1 and group 2, simulate both group 1 and
group 2 to see how policies would be applied for that agent.

8. After you have specified the optimal ranking order, you can publish the new ranking.

Simulation Examples

This section contains simulation examples for Agent Endpoint policies and Agent Log policies. Note that
Windows policies have the same behavior as Agent Endpoint policies.
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Agent Endpoint Policies Examples

The Simulated Source Settings panel shows each individual policy setting, along with the governing
policy for each setting.

Examine AE Policy 1, AE Policy 2 and AE Policy 3 to see which values are set in those policies.
AE Policy 1 has Agent Mode set:

-+ Create New

AE Policy 1
[] POLICY NAME 4  APPLIED TO GROUPR(S) POLICY DESCRIPTION SOURCE TYPE PUBLICATION STAT. )

Test Agent Endpoint policy settings

AE Policy 1 AEDO1 Test Agent Endpoint policyserti Agent Endpaint Published
AE Policy 2 Test policy 2 for agent endpoint_  Agent Endpaint Published
AE Policy 3 Third policy Agent Endpoint Published
Defautt EDR Policy These are the settings thatare . Agent Endpaint Published
Defauit File Policy These are the settings thatare . Agent Log Files Published
Defauit Windows Log . These are the settings thatare . AgentWindowslogs  Published Ll

group 1 Agent Windows Logs Published

Agent Windows Logs Published

AE Policy 2 has a scan schedule set, as well as limiting the CPU maximum to 18%:

+ Create New

AE Policy 2
a POLICY NAME 4+ APPLIED TO GROUP(S) POLICY DESCRIPTION SOURCE TYPE PUBLICATION STAT..

Test policy 2 for agent endpoint policy settings
AE Policy 1 AEOO1 Test Agent Endpoint policy setti.  Agent Endpoint Published policy 5 O

AE Policy 2 AEDO2 Test palicy 2 for agent endpoint . Agent Endpoint Published
AFE Policy 3 Third policy Agent Endpaint Published
Defautt EDR Policy olic These are the settings thatare _  Agent Endpoint Published

Defauit File Policy olic These are the settings thatare .. Agent Log Files Published
n Enabled

Every 1 day(s)
group 1 AgemtWindowslogs  Published n 18%

Default Windows Log . olic These are the settingsthatare . AgentWindowslogs  Published

Agent Windows Logs Published

n 2019-05-13 04:21
admin

n 2019-05-13 04:21
admin

0 2019-05-13 04:21

AE Policy 3 has Agent Mode set (to Insights), and sets the UDP Port to 454:
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AE Policy 3
[0 POLICY NAME 4  APPLIED TO GROUP(S) POLICY DESCRIPTION SOURCE TYPE PUBLICATION STAT.. v

Third policy

AE Policy 1 AEDO1 Test Agent Endpoint policy setti_  Agent Endpoint Published
AE Palicy 2 AEDO2 Test policy 2 for agent endpoint . Agent Endpaint Published
AE Policy 3 AE003 Third policy Agent Endpoint Published
Default EDR Policy olic These are the settings thatare . Agent Endpoint Published
Defautt File Policy These are the settings thatare . Agent Log Files Published
Defauit Windows Log olic These are the settings thatare _  Agent Windows Logs Published
winl group 1 Agent Windows Logs Published

win2 Agent Windows Logs Published

2019-05-13 04:43
EL
2019-05-13 04:43
EL T
2019-05-13 04:43

No Settings Applied

When none of the policies are simulated, you can see that the Default EDR Policy governs all behavior.

SOURCE TYPE: Agent Endpoint @ SIMULATED SOURCE SETTING

SIMULATE GROUP NAME POLICY APPLIED

Disabled Default EDR Policy - None
[ ] AE Policy 1

[ ] AE Policy 3
AE Policy 2

Advanced Default EDR Policy - None

Disabled Default EDR Policy - None
Disabled Default EDR Policy - None

Disabled Default EDR Policy - None

s Per Packager Default EDR Policy - None
443 Default EDR Policy - None
15 Minutes Default EDR Policy - None
444 Default EDR Policy - None
30 Seconds Default EDR Policy - None

Simulate a Single Policy

When you select the AE001 Group, you can see that the values set in AE Policy 1 govern the behavior
Agent Mode, as well as the Default EDR Policy being used for all unset parameters.
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SOURCE TYPE: Agent Endpoint (& SIMULATED SOURCE SETTINGS (D

RANK SIMULATE GROUP NAME POLICY APPLIED TR LTS ER | (B — S T

Disabled Default EDR Policy - Mone
AE Policy 1

AE Palicy 3

AE Policy 2

Disabled Default EDR Policy - None
Disabled Default EDR Policy - Mone

Default EDR Policy - None

olicy - None
15 Minutes Default EDR Policy - None
444 Default EDR Policy - None
30 Seconds Default EDR Policy - Mone

Simulate Multiple Policies

When you select multiple groups and policies, you can see the effects of each policy, based on the
current ranking.

SOURCE TYPE: Agent Endpoint (D SIMULATED SOURCE SETTINGS (@

RANK  SIMULATE GROUP NAME POLICY APPLIED TSR [ET 1R — (EYATITE

Enabled AE Policy 2 - AED02
09:00 Default EDR Policy - None

] AE Policy 2
E\.reg 1 day(s) on AE Policy 2 - AE0O2
MONDAY

o AE Policy 3 Maximum 18 % AE Palicy 2 - AEDO2
M Maxi 10 % Default EDR Policy - None

] AE Policy 1

NG POLICY - GROUP

= Mode  Insights AE Policy 3 - AEOO3

SOVER CY - GROUP

Disabled Default EDR Policy - None
Disabled Default EDR Policy - None

EDR Policy - None

OVER POLICY - GROUP

Default EDR Policy - None
15 Minutes Default EDR Policy - None
454 AE Policy 3 - AEOO3
30 Seconds Default EDR Policy - None
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You can see that Agent Mode is set to Insights: this is because AE Policy 3 is ranked above AE Policy
1, so the higher ranked policy's setting is used. None of the other parameters are set in more than a
single policy, so for those, each policy's setting is used. Since AE Policy 1 only has Agent Mode set—
and AE Policy 3 ranks higher and sets a different value—AE Policy 1 does not govern any of the EDR
settings. And finally, for parameters not set in any of the simulated policies, the Default EDR Policy
settings are used.

File Log Policies Simulation Example

The collection of parameter values into a complete policy works a bit differently for File Log policies
than for EDR or Windows policies. To determine which values are applied from which policies, note the
following:

« Each event source type acts as a separate setting. That is, if a policy has values for both Apache and

RSA Access Manager, for example, each of those event source types is treated as a separate set of
values.

« When an endpoint inherits values, it might not only get values from the highest ranked policy that has
a value set. It might, for example, inherit Apache values from one policy, and RSA Access Manager
settings from another.

« If you consider a set of File Log policies that all include settings for the same event sources, then they
behave the same as EDR and Windows policies.

Consider the following example, where there are three log file policies—two with Apache source types
and one with MS SQL event source type.
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« File policy Apache Source 1:

Apache Source 1

Dizabled

EndpointLogHybridl - Log
Decoder

Dizabled

Enabled

Collect new data only

ASCIH

C/Program
Files/Apache/error_logsf* log,
C/Program FlesfApache
SoftwarefApache vé/logsr*_log,
C/Program FilesfApache
SoftwarefApache viflogs*_log,
C/Apachef/Apache log

127000, Mozilla\4h 08

Enabled

Collect historical and new data
ASCIH

DofApachefApache_log

10,025

wnewexample\.com

« File policy Apache Source 2:
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Apache Source 2

EndpointLogHybridl - Log
Decoder

EndpointLogHybridll - Log

Decoder

Enabled

Collect new data only
Wide Char

C/Program Fles/Apache
SoftwarefApache vaflogsr*_log,
C/Program Riles/Apache
SoftwarefApache viflogsr*_log

« File policy Microsoft SQL Source:
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Microsoft SOL Source

Enabled

EndpointLogHybridll - Log
Decoder

TS

Disabled

Collect new data only
Local Encoding

CAMSSOQL\ms=ql log,
Wi U.D.E.E\MSF?% Lvmssgllog

Examine two of the possible ranking orders:

« Simulate policies 1: Apache Source 1, 2: Apache Source 2. Note that in this case, the MS SQL
policy is not simulated.
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SOURCE TYPE: Agent Log Files (O

RANK  SIMULATE GROUF NAME
Apache Machines 1
M5SQL Machines

Apache Machines 2

POLICY APFLIED SOURCE COUNT
Apache Source 1
Microsoft SQL Source

Apache Source 2

Reset Ranking | | SetTop Ranking | |PUblShRanking

In this case, all Apache settings for the group are inherited from the Apache Source 1 policy.

SIMULATED SOURCE SETTINGS (0

GOVERNING POLICY - GROUP

2 - Apache
iche Source 2 - Apache
hines 2

£ Disabled che Source 1 - Apache
Machines 1

- Apache

Collect new data Source 1-Apache
only N es 1

e AsCI Source 1-Apache

aths  C-/Program - Apache
Fil ’A.Fnacher’err-:-r_l\. lachines 1

es/
Softwal
L
~/P

= 1 LOLT che Source 1 - Apache
Mozilla\i4.08 Machines 1

Enabled iche Source 1-Apache
Machines 1

" Collect historical Afache Source 1-Apache
and new data Machines 1

ASCH Source 1-Apache
ines 1

Mach:
DcfApachefApache.l iche Source 1 - Apache
e == P

chines 1
Afache Source 1-Apache
N es 1

v examplel.co Source 1-Apache
m Machines 1

o Move the Apache Source 2 policy higher than Apache Source 1 policy, and add the Microsoft SQL
Source policy. Simulate policies 1: Apache Source 2, 2: Microsoft SQL Source, 3: Apache Source

1.
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SOURCE TYPE: Agent Log Files (0 SIMULATED SOURCE SETTINGS (0

RANK  SIMULATE GROUP NAME POLICY APPLIED SOURCE COUNT GOVERNING POLICY - GROUP

L] Apache Machines 2 Apache Source 2

isa 5 Y
. Apache Machines 1 Apache Source 1 2 acl ﬁgﬂ"‘rce U=tz
P che Source 2 - Apache

Endj tLogHybridl
I- ng Deco%gg ifa
mns urce 2 - Apache

L MSSQL Machines Microsoft SQL Source

Disabled che Source 1- Apache
Machines 1

Enabl € Source 2 - Apache
es 2

Collect new data e Source 2 - Apache
only es 2

Wide Char 2- Apache

C/Program 2 - Apache
Files/Apache c 2
Software/Apache

Microsoft SQL Source -
Machines

Collect newdata  Microsoft SQL Source -
only ines

Local Encoding oft SQL Source -
€S

gl icrosoft SQL Source -
chines

1002 FAMSSQLY
mssql.log

[ —— Publish Ranking

In this case, all Apache settings for the group are inherited from the Apache Source 2 policy, and
groups also get the MS SQL settings.

So, the Apache settings are inherited from the highest ranked Apache policy only, but the source settings
as a whole are combined to include settings from each event source type.

The SIMULATE Slider

The slider has two positions:

e On: n
° Off u

If the simulate slider is ON for a policy, that policy's values are factored into the complete set of
governing settings. If the slider is OFF for a policy, the setting for that policy have no effect on the list of
the governing settings.
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An administrator can configure the retention policies to retain the Endpoint data based on the age or the
storage size. By default, days and size-based retention policies are enabled.

To change the configuration for age-based retention:
Q
1. Goto (Admin) > Services.

2. In the Services view, select the Endpoint Server service.

Click 8- and select > View > Config.
4. Click the Data Retention Scheduler tab.

R SA Investigate Respond Jsers Hosts Files Dashboard

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH ¢ LLNESS SYSTEM SECURITY

. Change Service |  endpointloghybrid1 - Endpoint Server | Config «

Data Retention Scheduler [EVlaETd E (T ST BRIV

vats Retentinn Palicy
dta Retention PolCy

[# Enable

Threshold 30 ¢ Days

Run Everyday v at 00:00:00 hh:mm:ss

[ Enable

Threshold 90 ¢ Days

Run Everyday ~ at 01:00:00 hh:mmiss
Downloaded Data (MFT, System Dump and Process Dump) Retention Policy
™ Enable

Threshold 90 ¢ Days

Run Everyday v at 00:00:00 hh:mm:ss

5. Inthe Data Retention Policy panel, by default, the Threshold is set to 30 days, and Run to
Everyday. This means only 30 days of Endpoint data is retained and the older data is deleted from
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the database.
6. Click Apply.

To change the configuration for size-based retention:

By default, for the size-based retention, the rollover-after value is set to 80 and rollover-
chunk-size is set to 10. This means that when the storage size exceeds 80 percent of the space
allocated for the disk partition, 10 percent of the older Endpoint data is deleted from the database.
However, you can change these values as follows:

QA
1. Goto (Admin) > Services.

2. In the Services view, select the Endpoint Server service.

3. Click & and select > View > Explore. The Explore view is displayed:

RSA Investigate Respond Users Hosts Files Dashboard Reports

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

# Change Service |  endpointloghybrid1 - Endpoint Server |  Explore &

Jrsalendpoint/config/data-retention endpointloghybrid1 - Endpoint Server

= endpointloghybrid? -...

enabled true
B & endpointloghybrid1 - Endpoint Server
initial-rollover-delay 1 MINUTES
[Jadmin/security/settings
y = recurrence-interval 000***
[Jems/servicesstatus
rollover-after 80
configuration
o 8 rollover-chunk-size 10
data/application
[ datarapy rollover-delay 10 MINUTES
Bdatascontrol size-based-rollover-enabled true
I«
[Jendpoint/agent/udp/handler threshold-in-days 20

B [endpoint/certificate
[Dendpoinvcommand
[Jendpoint/config/data-retention
[Tendpoint/config/downloaded-data-
[Jendpoint/config/inactive-machine-r.
[Jendpoint/data-retention

[ endpoint/data-store-thresholds

4. In the left panel, select endpoint/config/data-retention.

5. Edit the configurations based on your requirements.
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Managing Inactive Agents

An administrator can configure the inactive agent retention policy to delete data of agents that are
inactive, from the Endpoint Server. On deletion, the Endpoint Server stops collecting data from these
agents. By default, this option is enabled.

To configure the inactive agent retention policy:
Q
1. Goto (Admin) > Services.

2. In the Services view, select Endpoint Server.

Click 8- and select > View > Config.
4. Click the Data Retention Scheduler tab.

R SA In espo U Hosts File Dashboard

HOSTS SERVICES VEN 2 E INT SOUR HEALTH LLN SYSTEM

. Change Service |  endpointloghybrid1 - Endpoint Server | Config

Agent Packager  Relay Server

[ Enable
Threshold 30 ¢ Days
Run Everyday v at 00:00:00 hh:mm:ss

[+ Enable

Threshold 90 ¢ Days

Run Everyday ~ at 01:00:00 hh:mm:ss
ownloaded Data (MFT, System Dump and Process Dump) Retention Policy
¥ Enable

Threshold 90 ¢ Days

Run Everyday v at 00:00:00 hh:mm:ss
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5. In the Inactive Agents Retention Policy panel, by default, the Threshold is set to 90 days and Run
to Everyday. This means that the data of agents that have not communicated with the Endpoint server
for 90 days is deleted from the database.

6. Click Apply.

Note: The Inactive Agents Retention Policy is not applicable for NetWitness Endpoint 4.4.0.2 or later
agents.
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Configure Retention Policy for Memory Dumps and

MFT

An administrator can configure the retention policy to delete the downloaded system dump, process
dump, and Master File Table (MFT) from the Endpoint server based on the number of days. By default,
this option is enabled.

To configure the retention policy:

QA
Go to (Admin) > Services.

1.
2. Inthe Services view, select Endpoint Server.
3. Click & and select > View > Config.
4. Click the Data Retention Scheduler tab.
RSA Inve Hosts Files Dashboard
HOSTS SERVICES NT S CES LNESS M SECURITY
. Change Service | endpointloghybrid1 - Endpoint Server | Config &
Agent Packager  Relay Server
ta Reter
[# Enable
Threshold 30 ¢ Days
Run Everyday v at 00:00:00 hh:mm:ss
nactive Agents Reter P
[ Enable
Threshold 90 ¢ Days
Run Everyday ~ at 01:00:00 hh:mm:ss
ownloaded Data (MFT, System Dump and Process Dump) Retention Policy
™ Enable
Threshold 90 ¢ Days
Run Everyday v at 00:00:00 hh:mm:ss
=]
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5. Inthe Memory Dumps and MFT Retention Policy panel, by default, the Threshold is set to 90
days and Run to every day. This means only 90 days of data is retained and the older data is deleted
from the Endpoint server.

6. Click Apply.
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(Optional) Installing and Configuring Relay Server

Note: The information in this topic applies to RSA NetWitness® Platform Version 11.3.1 and later.

Relay Server (referred to as RAR in RSA Endpoints) extends NetWitness Platform’s visibility into
endpoints when they are outside the corporate network. The Relay Server deployed in a cloud or DMZ
relays the endpoint data between the hosts and the Endpoint Server. The hosts that are outside the
corporate network send the endpoint data to the configured Relay Server and the corresponding Endpoint
server pulls the data.

Note: If you have Windows hosts that are outside the corporate network, the log data is not sent to the
Relay Server.

You can configure a Relay Server on the Endpoint Server Config view. Once the Relay Server is
configured, the policy for the host is automatically updated and you can view the Relay Server settings
on the Host Details view > Policy Details panel.

You can configure a single Relay Server with one or more Endpoint servers. In this case, the Relay
Server ensures that the endpoint data reaches the Endpoint Server configured in the policy.

The following describes the architecture of the Relay Server.

DMz

r i
- ~ ENDPOINT LOG
Relay server HYBRID : N

.- . host l Endpoint Server
< > . —
@ ) 443 L - ongo Service

= 1A Relay Server g feenne ‘.\fga-'.-:a;( _

<._. aa— J | NGINX ‘l Cnormalized endpoint meta

| Concentrator

—

c
A vy Log Decoder
4

N oy

The following flowchart explains how the host switches to the Relay Server.
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configured?
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Installing the Relay Server

The Relay Server installer contains binaries, certificates, configuration files, and the installation script
required to install the Relay Server.

IMPORTANT:

- The Relay Server version must match with the corresponding NetWitness Endpoint Server version. If
you plan to upgrade a Relay Server to a newer version, first upgrade the Endpoint Server, then
download the Relay Server installer, and run the installer script.

- Operating System updates and general system hardening on the Relay Server must be managed by
the customer according to standard best practices. The Relay server package does not contain OS
updates and the operating system will not be updated as part of the standard NetWitness update
process.

- Do NOT run the nwsetup-tui script to install the Relay Server. Follow the instructions in this
document only as Relay Server is an independent server and not part of NetWitness Platform Ul
(Admin > Hosts).

Installation Media

The Relay Server can be installed only on a CentOS 7 or NetWitness Platform 11.4.0.0 or later base
image which is available for download from Download Central (https://download.rsasecurity.com). Also,
make sure that the Relay server host is connected to internet to download the required dependencies.

For more information on deploying Relay Server host on a:

o« DMZ - see "Step la. Deploy the Virtual Host to create VM" in the Virtual Host Installation Guide.
o Cloud

o see "Step 1. Deploy NW Server Host" in the Azure Installation Guide.

o see "AWS Deployment" in the AWS Installation Guide.

Relay Server Host System Requirements

mm CPU Cores m Ideal Beacon Interval

20000 32 GB 4 cores 200GB 5 min

To install the Relay Server:
1. Log in to NetWitness Platform.

4
2. Click (Admin) > Services.

3. Select the Endpoint Server service and click ﬁ " > View > Config > Relay Server tab.

4. Inthe Download Installer section, enter the installer password and click Download to download the
Relay Server installer file (RelayInstaller.zip).

5. Copy the Relay Server installer file (RelayInstaller.zip) to the Relay Server host.
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10.

11.

Unzip the Relaylnstaller.zip file on the Relay Server host. For example:

/home/RelayInstaller.zip
unzip <installer path>

Set up the execution permission using the following command:

chmod +x install.sh

Run the installer script using the following command:

./install.sh

The All necessary RPMs will be installed without further prompts is displayed.
Enter Y to continue the installation.

The password prompt is displayed.

Enter the password.

Note: Make sure you enter the same password you set while downloading the Relay Server
installer.

Note: In case if you are re-installing the Relay Server host. Do you wish to update the list prompt
is displayed.
- Enter Y to update the Endpoint server IPs.

Enter the Endpoint Server IPs prompt is displayed.

Enter all the Endpoint server IPs you plan to configure with the Relay server with comma separated.

If the Relay Server installation is successful, you can check the status of the services:

o Check if the Relay Server is up and running:

systemctl status rsa-nw-relay-server

o Check if Ngnix is running:

systemctl status ngnix

You can also update Endpoint Server IPs without installing the Relay Server.

To update Endpoint Server IPs without installing the Relay Server:

L.

Run the following command:
bash /var/netwitness/relay-configure-allowed-hosts.sh

The list of all the configured Endpoint server IPs is displayed and Do you wish to update the list
prompt is displayed.

Enter Y to update the list of Endpoint server IPs.
Enter the Endpoint Server IPs prompt is displayed.
Enter a comma-separated list of all the Endpoint Server IPs to update.

The list of updated IPs is displayed.
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Configuring the Relay Server

Make sure you have installed the Relay Server.

Note: During Relay Server host installation, firewalld is configured to allow incoming connections
only on TCP ports 443 and 22.

To configure the Relay Server:
1. Log in to NetWitness Platform.

4
2. Click (Admin) > Services.

3. Select the Endpoint Server service and click Qe > View > Config > Relay Server tab.

The Relay Server tab is displayed.

4. Select the Enable Relay Server check box to enable the Relay Server configuration.

Note: To disable the Relay Server, clear the Enable Relay Server check box.
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Caution: Before you disable the Relay Server configuration, if the hosts will be always roaming
make sure to migrate these hosts to an alternate Endpoint server configured with a different Relay
server. Else these hosts will not be able to connect back to the corporate network. When you
disable the configuration, the Relay Server settings are removed from the EDR policy.

5. Inthe Configure section:

a. Enter the ESH.

Note: This should be a hostname that can only be resolved on the corporate internal DNS and not
on public internet DNS (ex: 1.1.1.1 or 8.8.8.8). It is used to determine if the host running the
Endpoint agent is connected to the internal network (physically on premise or via VPN).

a. Specify the Relay Server, Port and HTTP Beacon Interval.

IMPORTANT: The relay server needs to be a hostname that can be resolved correctly on both
internal DNS (with the internal IP) and public DNS (with the public IP).

6. Click Test Connection to check if the Relay Server is reachable.

Note: When using CentOS 7 configuration, if the test fails on a cloud installation, you can add the
HTTP TCP port by:

1. List the configured port: semanage port -1

2. Add port/TCP: semanage port -a -t http port t -p tcp [port]
For example:

1. semanage port -1

2. semanage port -a -t http_port t -p tcp 7058

7. Click Save Configuration to save the configuration.

Note: Before you modify the Relay Server configuration, perform any one of the following:
- Make sure that the hosts are inside the corporate network so that the policy with the Relay Server
configuration is applied.

- If hosts will always be roaming, then migrate these hosts to an alternate Endpoint server
configured with a different Relay Server.

IMPORTANT: You must change the root password after you deploy the Relay Server host.
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Integrating NW Endpoint 4.4.0.2 or Later with NW

Platform

You can configure the Endpoint Metadata for the NetWitness Endpoint 4.4.0.2 by integrating the Meta
Integrator service in the NetWitness Endpoint 4.4.0.2 directly to a Log Decoder. You can view the
Endpoint metadata in the Investigate > Navigate and Events views. This integration includes the
following steps:

o Enable Metadata Forwarding

¢ Enable Machines to Forward Metadata

Enable Metadata Forwarding

To enable the Metadata Integrator service for the selected NetWitness Endpoint 4.4.0.2 agents, run the
following command:

ConsoleServer.exe /nw-investigate enable

Enable Machines to Forward Metadata

After you enable the Metadata Forwarding using any one of the above options, perform the following to
enable the machines to forward metadata to the Log Decoder.
1. Open the NetWitness Endpoint 4.4.0.2 user interface.

2. Click Machines from the left panel. The list of available machines are displayed.

79 Integrating NW Endpoint 4.4.0.2 or Later with NW Platform



NetWitness Endpoint

NetWitness Endpoint

¢ Configure

Tools

View About

Main Menu ]

“
=5

Machines

T

Modules

an

Certificates

>

InstantiOCs

@

Downloads

E‘fé

Events

Senver
Configuration

54 Machines X

Filters

Select an 1OC

Machine Status

Online
Operating System
Windows
Containment
Contained
ECAT.Components
Machine ECAT
Machine Netwark

Machine Physical

Select Admin Status

Select Network Segment  ~

Offline

Mac

Security Configuration

Linumx

Machine Sta...

=
=
=

Machine Name
COMSOLESERVER @) 1024
Inensuahegm.... @ ]

RhelE7x54 ® o

IOC Score w | ... ..

Version Info
4400
4.4.0.2

4402

Last Scan

/22018 3:03:14 PM ...

.. Onling

Operating ...

' Microsoft ..

Open

Request Scan...
Cancel Scan...
Medify Status...
Medify Comment...
MNetwitness Investigate...
Containment
Roaming
Configuration Group
Forensics

Agent Maintenance

Advanced

Local IP
10.40.5.50
176.38

115.180

3. Select machines for which you want to forward metadata to the NetWitness Endpoint Server.

4. Right-click and select the NetWitness Investigate option.

The Change NetWitness Investigate Status dialog is displayed.
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Configure Tools | View About

a

Main Menu Machines

Filters
3 Machine 5ta.. Machine Name | 1IOC Score w ... ... Versioninfo  Last Scan Operating ... Local IP
.‘ Select am 1OC. - = consoleserver @) 1024 4400 V22018 X014 PM . 7 Microsoft .. 10.40.5.50
' ] inensudhegm?.... ] 4402 - ] Mac OSX1... 10.87.176.33
Dashboard Select Admin Status -
= Rhel§Tasd ® ¢ 4402 f ¥ Red HatEn... 10.40.15.190
r\ Select Network Segment  +
Machines Online Offline .
» a Change NetWitness Investigate status
Operating System
§ Windows Mac * Enable Netwitness investigate
Modules Disable NetWitness Investigste
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g Contained
ECAT.Components Ma... Machine Name Version Infa IOE Scare MetWitness Investigate
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Select the Enable NetWitness Investigate option.
Click Apply.

To verify if the Enable NetWitness Investigate option is enabled, repeat step 4.
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Endpoint References

This section is intended to help you understand the purpose of the Services Config View for the Endpoint
Server. For each configuration, there is a brief introduction and a What Do You Want To Do table with
links to related procedures. In addition, it includes workflow and Quick Look sections to highlight
important features in the user interface.

You can view the complete service nodes in tree form in the Services Explore view. For more
information, see the "Services Explore View" topic in the Hosts and Services Getting Started Guide.
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General Tab

In the General tab, you can configure the Endpoint metadata forwarding for multiple endpoint servers.
To access this view:

Q4
1. Goto (Admin) > Services.
2. In the Services view, select Endpoint Server for which you want to configure the metadata
forwarding.
3. Click B and select > View > Config.
4. Click the General tab.

Workflow

Analyze Event Data
(Navigate and
Events View)

Investigate
Endpoint Data
(Hosts and Files
View)

Manage Endpoint

You are here Settings
Data Retention

Generate Agent ( ) of Endpoint
— Installer Optiona Data .
Install Endpoint o :.}?:!ov - E:;E;ﬁ:lti + Install Agents Install and Define Groups Manage Sl AR AT
Log Hybrid NE}SI::RIDIn an e on Hosts Configure Relay and Policies (EEnE LTS g Data (Navigate and
ies orwarding through third- Server Retention of Events View)
party tool

Memory
Dumps and
Master File

Table (MFT) Analyze Process

(Hosts View)

Generate Reports
and Alerts

What do you want to do?

T e

Administrator ~ Configure Endpoint Metadata Forwarding for the Configuring Metadata

NetWitness Endpoint Agents* Forwarding
Administrator Configure Endpoint Metadata Forwarding for the Integrating NW Endpoint
NetWitness Endpoint 4.4.0.2 or later Agents* 4.4.0.2 or Later with NW
Platform

*Y ou can perform this task in the current view

Quick Look
The following figure is an example of the General tab.
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Nt

Address Protobuf SSL Protobuf Port REST SSL REST Port User Name

false 50202 false 50102 admin

RS /\ NETWITNESS' PLATFORM

Click == to view the Available Services dialog.

Click ~ to delete the added service.
Click E to edit the information for the added service.

Click & start to start the Endpoint metadata forwarding.
Click = swn. to stop the Endpoint metadata forwarding.

The following table describes the fields in the General tab.

o owan

Address Displays the IP address of the Log Decoder.

Protobuf Indicates if SSL is enabled on Protobuf. By default, this option is disabled.
SSL

Protobuf Displays the port used for Protobuf. By default, the port is 50202.
Port

REST SSL  Indicates if SSL is enabled on the REST port in the Log Decoder. By default, this
option is disabled.

REST Port  Displays the port used for REST communication. The default value is 50102 (for non-
SSL) and value 56102 (for SSL).

User Name  Displays the user name.

Raw Data Sends a brief summary of the session along with the metadata if enabled. By default,
this option is disabled.
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Data Retention Scheduler Tab

In the Data Retention Scheduler tab, you can configure data retention, inactive agents, and memory

dump and MFT retention policies for multiple endpoint servers. To access this view:
A
1. Goto (Admin) > Services.

2. In the Services view, select Endpoint Server.

3. Click = °
4. Click the Data Retention Scheduler tab.

and select > View > Config.

Repeat the above steps to configure data retention settings for multiple endpoint servers.

Workflow

You are here

Manage Endpoint
Settings
Data Retention
of Endpoint
Data

Generate Agent
Installer

(Optional)

Install Endpoint Applil)(?t':g: and :::25;2 0 =R Irgllons Manage
Log Hybrid S e on Hosts Configure Relay and Policies Inactive Agents

through third- Server

tool

Retention of
Memory
Dumps and
Master File

I
|
I
I
I
I
I
I
I
I
Define Groups AN .

I
I
|
|
|
|
I
| Table (MFT)
|

I

What do you want to do?

Analyze Event Data
(Navigate and
Events View)

Investigate
Endpoint Data
(Hosts and Files
View)

Analyze Endpoint
Data (Navigate and
Events View)

Analyze Process
(Hosts View)

Generate Reports
and Alerts

Administrator Configure Data Retention ~ Configuring Data Retention Policy
Policy*
Administrator Configure Inactive Agents Managing Inactive Agents
Policy*
Administrator Configure Memory Dumps ~ Configure Retention Policy for Memory Dumps and

and MFT Policy* MFT

*Y ou can perform this task in the current view
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Quick Look

The following figure is an example of the Data Retention Scheduler tab.

R S A Investigate 2 nd Users Hosts Files Dashboard Reports

HOSTS SERVICES J S0 3 ENDPOINT S¢ HEALTH JELLNESS 5Y SECURITY

- Change Service |  endpointloghybrid1 - Endpoint Server | Config

General Data Retention Scheduler [ENEnd =l ETC NIRRT g

Data Retention Policy

™ Enable

Threshold 30 | Days

Run Everyday v | at 00:00:00 hh:mm:ss
Inactive Agents Retention Policy

¥ Enable

Threshold a0 | Days

Run Everyday v at 01:00:00 hh:mm:ss

Downloaded Data (MFT, System Dump and Process Dump) Retention Policy

™ Enable

Threshold a0 ¢ Days

Run Everyday v | at 00:00:00 hh:mm:ss
Features

The following table lists the fields for data retention policy.

s Jowamin

Enable Enables the configuration for the data retention policy. By default, this option is enabled.

Threshold  Displays the number of days the Endpoint data is retained in the database. By default,
the Threshold is set to 30 days. The data older than 30 days is deleted from the database.
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o Jowamin

Run

Apply

Reset

Displays the schedule for running the data retention job. By default, the database check
occurs everyday at 00:00:00 AM. You can select the frequency from the drop-down list
(Everyday, Weekdays, Weekends, or Custom, where Custom allows you to select one or
more specific days of the week) and time to run the job.

Overwrites any previous schedule for the data retention policy and applies the new
schedule immediately.

Resets the schedule to the default settings.

The following table lists the fields for inactive agents retention policy.

o Jowamin

Enable

Threshold

Run

Apply

Reset

Enables the configuration for the inactive agents policy. By default, this option is
enabled.

Displays the number of days the inactive agents are retained in the Endpoint Server. By
default, the threshold value is 90 days.

Displays the schedule for running the inactive agents retention job. By default, the
database check occurs everyday at 00:00:00 AM. You can select the frequency from the
drop-down list (Everyday, Weekdays, Weekends, or Custom, where Custom allows you
to select one or more specific days of the week) and time to run the job.

Overwrites any previous schedule for the inactive agents retention policy and applies the
new settings immediately.

Resets the schedule to the default settings.

The following table lists the fields for memory dumps and MFT retention policy.

e

Enable Enables the configuration for the memory dumps and MFT policy. By default, this option
is enabled.

Threshold  Displays the number of days the memory dumps and MFT are retained in the Endpoint
Server. By default, the Threshold is set to 90 days. The data older than 90 days is
deleted from the Endpoint Server.

Run Displays the schedule for running the retention job. By default, the database check
occurs everyday at 00:00:00 AM. You can select the frequency from the drop-down list
(Everyday, Weekdays, Weekends, or Custom, where Custom allows you to select one or
more specific days of the week) and time to run the job.

Apply Overwrites any previous schedule for the retention policy and applies the new schedule
immediately.

Reset Resets the schedule to the default settings.
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Agent Packager Tab

In the Agent Packager tab, you can generate an agent packager and agent installer. To access this view:
QA

1. Goto (Admin) > Services.

2. In the Services view, select Endpoint Server.

3. Click 2 and select > View > Config.

4. Click the Packager tab.

Workflow

Analyze Event Data
[Navigate and
Events View)

Investigate
Endpoint Data
(Hosts and Files
View)

Manage Endpoint
Settings
Data Retention

You are here

Generate Agent of Endpoint

Installer (Optional) Data

Install Agents Install and Define Groups Manage

on Ho Configure Relay and Policies Inactive Agents
Retention of
Memory
Dumps and
Master File

q Deploy Configure
Install Endpoint
= Application and Metadata
Log Hybrid .
ESA Rules Forwarding

Analyze Endpoint
g Data (Navigate and
Events View)

Analyze Process
(Hosts View)

Table (MFT)

Generate Reports
and Alerts

What do you want to do?
_m
Administrator ~ Generate an Agent Packager for Endpoint NetWitness Endpoint Agent
Data Collection* Installation Guide

Administrator ~ Generate an Agent Installer®

Administrator  Install and Configure Relay Server* NetWitness Endpoint Configuration
Guide

*Y ou can perform this task in the current view

Quick Look

The following figure is an example of the Agent Packager tab.
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/% Change Service | 1151NodeX2 - Endpoint Server |

General  Data Retention Scheduler EEEMAETCERE

Agent Packager

E

C None t te Thumbprint

R'S /\ NETWITNESS® PLATFORM
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Relay Server Tab

In the Relay Server tab, you can download and configure Relay Server . To access this view:
1. Goto ADMIN > Services.

2. In the Services view, select Endpoint Server.

hed

Click & and select > View > Config.
4. Click the Relay Server tab.

Workflow

Analyze Event Data
[Navigate and
Events View)

Investigate
N Endpoint Data
LATse Fndpolnt (Hosts and Files
Settings i
. View)
You are here Data Retention

of Endpoint
(Optional) Data
Install and Define Groups Manage
Configure Relay and Policies Inactive Agents
Server Retention of
Memory
Dumps and
Master File
Table (MFT)

Generate Agent
Installer

+ Install Agents
on Hosts
through third-
party tool

Configure
Metadata
Forwarding

Analyze Endpoint
g Data (Navigate and
Events View)

Install Endpoint :_)?p!ov and
Log Hybrid Application an
ESA Rules

Analyze Process
(Hosts View)

Generate Reports
and Alerts

What do you want to do?

N T R

Administrator Install Relay Server*  (Optional) Installing and Configuring Relay
Server

Administrator Configure Relay (Optional) Installing and Configuring Relay
Server* Server

* You can perform this task in the current view.

Quick Look

The following figure is an example of the Relay Server tab.
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Data Retention Scheduler  Agent Packager [ECENL U

Features

The following table lists the fields for Relay Server tab.

I

Download Installer

Password Enter the relay server installation password. For example, netwitness. Password
must be minimum of 3 characters and can contain alphanumeric and special
characters.

Note: You must provide the same password when prompted during Relay Server

installation.
Download Click to download the Relay Server installer.
Enterprise Enter the hostname which can be resolved only within the corporate network.
Specific
Hostname (ESH)
Enable Relay Check Enable Relay Server for Agents outside the corporate network to connect to
Server the configured relay server. By default, this option is disabled.

Configure
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Server Hostname or IP of the Relay Server.

Port Port number. For example, 443.

HTTP Beacon Enter the Interval value ranges from 60 — 1440 minutes.
Interval

Test Connection  Click test connection to check if the relay server is reachable by the agents.

Save Saves the relay server configuration.
Configuration
Cancel Cancel the unsaved changes.
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Endpoint Sources - Groups

Note: The information in this topic applies to RSA NetWitness® Platform Version 11.3 and later.

Q
The (Admin) > Endpoint Sources view contains two tabs: Groups and Policies.

Workflow

Install Endpoint
Log Hybrid

Deploy
Application and
ESA Rules

What do you want to do?

o o oronmron

Administrator

Administrator

Administrator

Administrator

Administrator

Administrator

Administrator

Administrator

Administrator

create new groups™®
edit groups*®
edit ranking*

delete groups*

view default policies

create an EDR policy

create a Windows Log

policy

edit policies

delete policies

Configure
Metadata
Forwarding

Analyze Event Data
(Navigate and
Events View)

Investigate
Endpoint Data
(Hosts and Files
View)

Manage Endpoint
Settings

You are here Data Retention

Generate Agent of Endpoint

Installer (Optional) Data -
Install Agents Install and Define Groups Manage Analyze F"dP‘}'"t
on Hosts Configure Relay and Policies it s g Data (Navigate and

through third- Server Events View)

Retention of
party tool

Memory
Dumps and
Master File

Analyze Process
(Hosts View)

Table (MFT)

Generate Reports

and Alerts

Create a Group

Edit a Group
Managing Groups

Delete a Group

Default Agent Endpoint (EDR)
Policy

Create an EDR Policy

Create a Windows Log Policy

Edit a Policy
Delete a Policy

*You can perform this task in the current view.
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Related Topics

o Endpoint Sources

o Managing Policies

Quick Look

Below is an example of the Groups tab:

RSA Inv gate X gle Users osts Files Da: s Reports % admin

HOSTS SERVIC 2 EVENT SOURCES ENDPOINT SOURCES HEH& WELLNESS SYSTEM SECURITY

GROUPS  POLICIES

+ Create New Edit Ranking Edit Delete

[] GROUPNAME + SOURC.  POLICIES APPLIED GROUP DESCRIPTION PUBLICATION

o AlexEDR. Aledlelogs1 int,.. Published
Aled ogs2 Published
Servers with Encoding Published
Etienne's EDR V. Etienne._. int...  Published

Scott Test EDR 5 Published

'WIN-30FMF8G8CF5

2019-10-1601:08
admin
2019-10-1601:08
admin
2019-10-1601:08

Showing 5 outof Sitems | 1selected

Toolbar

o Create New: Lets you create a new group. For more information, see Create a Group

« Edit Ranking: Lets you edit the ranking of groups. For more information, see Managing
Groups
o Publish: Publishes the selected group or groups.

» Edit: Lets you edit the details of an existing group. For more information, see Edit a Group.

o Delete: Deletes the selected group or groups permanently. For more information, see Delete
a Group.
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ilter Pane

Filters: You can filter groups based on Policy Type and Publication Status.

To hide, click the Bl icon at the top-right of the panel. To display if hidden, click the icon
in the toolbar.

Reset: Removes the currently applied filter criteria.

or more information, see Filter Endpoint Groups.

R Groups List Pane

Group name: Name of the group.

Source Count: Number of hosts that are currently members of the group.
Policies applied: Lists the policies applied to this group.

Group description: Description of the group.

Policy Types Applied: Type of policies applied to the group: Agent Endpoint, Agent File
Logs, Agent Windows Logs, or any combination of these.

Publication Status: Status of the group - Published or Unpublished.

You can also sort on any column. If you mouse over a column header, a sort icon is displayed:

. Click the icon to sort by the selected column.

3 Group Details Pane

Displays the properties of the selected group.

Note: Click the row to view the Properties panel for a group.

Create Group

Below is an example of the Create Group dialog. The table describes the information and options in the
Create Group dialog.
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RSA 3 Files
HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

GROUPS POLICIES

& NEW GROUP

GROUP NAME
Entel

GROUP DESCRIPTION

Group Name Name of the group. The name should be unique.

Group Description Description of the group and should not exceed 8000 characters.

Define Group

Below is an example of Define Group panel. The table describes the information and options in the
Define Group panel:

RSA N e Users Hosts
HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

GROUPS POLICIES

o
& TEST GROUP Include source if Elll of the following conditions are met:

Group for test

Identify Group OS Type

between 10.100.01.01 and 10.10001.225

Add Condition

Next Save and Close Publish Now -
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Include source  Defines the conditions for an agent to be included in the group. Available options are

if ...of the all or any.

conditions are

met

Parameter The parameter can be OS Type, OS Description, Host Name, IPv4, or IPv6.

e OS Type - Type of operating system. Available options are: Windows, Linux, and
MacOS.

o OS Description - Description of the operating system. The description should not
exceed 256 characters. Available operators are: is equal to, contains, start with,
and ends with. For example, Microsoft Windows 10 Enterprise.

o Host name - Name of the host. The host name can contain only alphanumeric
characters. Available operators are: is equal to, contains, start with, ends with,
and in. For example, DESKTOP-QQPDNG3.

o IPv4 and IPv6 - IP address. Available operators are: between, in, not in, and
between. For example, 10.40.15.220.

Note: If you do not want to include certain IP addresses, use the Not in operator,
and enter the IP address separated by a space or a comma.

Operator The choice of values is dependent upon the parameter you chose. For example, if
your parameter is OS Type, the only operator available is in.

Value or The value or values to match. For the OS Type parameter, you can choose one or

values to match more values from the drop-down list. For all other parameters, you can enter free-
form text.

Note: Although you can enter any text for values, the system validates your entries
when you attempt to proceed to another screen, and will not allow you to proceed
until values are valid.

Add condition  Lets you add another condition.

Apply Policies

Below is an example of Apply Policies panel. The table describes the information and options in the
Apply Policies panel:
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RSA d Files s s ts E P ®  admin >
HOSTS  SERVICES  EVENT SOURCES ~ ENDPOINT SOURCES  HE/ . WELLNESS  SYSTEM  SECURITY

GROUPS  POLICIES

TESTGROUP Agroup does not need to apply a policy, however, for a policy to be active, it must be applied to a group.

If this step is skipped, policies can still be applied to this group later.

TYPE

0ose a Policy Type ®

Available Policies © Selected Policy ¢

POLICY NAME APPLIED TO GROUPS POLICY DESCRIPTION POLICY NAME APPLIED TO GROUPS POLICY DESCRIPTION

Saveand Close | | Publish Now

Source Type Defines the source type for the group. Available options are Agent Endpoint and
Agent Windows Logs.

Available Policies  List the available policies associated with the source type.

Selected Policies List the policies selected.

Add Another Lets you add another source type.

Source Type

Save and Close Saves the settings and closes the Create Group dialog.
Publish Now Publishes the created group.

Ranking Groups

Below is an example of the Ranking Groups dialog. The table describes the information and options in
the Ranking Groups dialog.

RISTAN

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

GROUPS POLICIES

ANKING G
Ranking is established per Policy Type. Select a Policy Type to continue.

POLICY TYPE

AGENT ENDPOINT

Endpoint References 98



NetWitness Endpoint

Fad osspton

Source Establishes ranking for the source type. Available options are Agent Endpoint and Agent
Type Windows Logs.

Below is an example of the Edit Ranking panel.
RSA R Fies  Dashboards R

HOSTS  SERVICES  EVENT SOURCES  ENDPOINT SOURCES  HEALTH & WELLNESS

GROUPS POLICIES

POLICY TYPE: Agent Endpoint ©® SIMULATED SOURCE SETTINGS ©®

Reset Ranking Set Top Ranking GOVERNING POLICY -
GROUP

RANK SIMULATE GROUP NAME POLICY APPLIED

Enabled Scott Test EDR - ScooM
1 L] ScooM Groupl Scott Test EDR Groupl
09:00 Scott Test EDR - ScooM
2 . Alex AlexEDR S )
Every1 Default EDR Policy - None
week(s) on

Monday
25% Default EDR Policy - None

18% Scott Test EDR - ScooM
Groupl

3 L] Etienne’s Gro... Etienne’'sEDR ...

Insights Etienne's EDR v - Etienne's
Group “#

Disabled Default EDR Policy - None

Previous Publish Ranking Cancel

From this panel, you can do the following:
o Drag the group up or down to change the priority. Priority decreases from top to bottom.

o Turn the Simulate slider on or off, to simulate your policy settings and how they affect the endpoints
within their groups. For more details, see Simulation Examples.

o Use the available buttons to perform actions:
« Reset Ranking: Resets the ranking to the original order.
« Set Top Ranking: Moves the selected group to the top.
o Previous: Navigates to the Choose Source Type panel.

« Publish Ranking: Lets you edit the details of an existing group. For more information, see Edit a
Group.

« Cancel: Discards the changes and returns to the Groups tab.
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Endpoint Sources - Policies

Note: The information in this topic applies to RSA NetWitness® Platform Version 11.3 and later.

Q
The (Admin) > Endpoint Sources view contains two tabs: Groups and Policies.

Workflow

Install Endpoint

Log Hybrid Application and

Generate Agent
Installer
& Install Agents
on Hosts
through third-
party tool

Deploy Configure
Metadata

ESA Rules Forwarding

What do you want to do?

T TR

Administrator
Administrator
Administrator
Administrator
Administrator
Administrator
Administrator
Administrator
Administrator

Administrator

create new groups

edit groups

edit ranking

delete groups

view default policies*

create an EDR policy*

create a Windows Log policy™
create a File Log policy*

edit policies™

delete policies*

*Y ou can perform this task in the current view

Analyze Event Data
[Navigate and

Events View)

Investigate
Endpoint Data
(Hosts and Files
View)

Manage Endpoint
Settings
You are here Data Retention
of Endpoint

(Optional) Data -
In.stalland Define Groups «  Manage q :a \:: .n tpmnd
Configure Relay and Policies Inactive Agents a :‘,Lnt‘s"{g,::e;;n
SE * Retention of

Memory
Dumps and
Master File

Analyze Process
(Hosts View)

Table (MFT)

Generate Reports

and Alerts

Create a Group

Edit a Group
Managing Groups

Delete a Group
Default Agent Endpoint (EDR) Policy

Create an EDR Policy

Create a Windows Log Policy

Create a File Log Policy

Edit a Policy
Delete a Policy
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Related Topics

o Endpoint Sources

o Managing Groups

Quick Look

Below is an example of the Policies tab:

POLICIES

Create New <> Publish Edit Delete
Corporate HQ
] POLICYNAME + APPLIEDTOGROUPS  POLICY DESCRIPTL POLICY TYPE PUBLICATIO_.
Policy for corporate HQ agents

AleEDR Aed AgentEndpoint  Published

Alexfielogs
AlexFielogs1
Aledogs2
CorporateHQ

2019-11-0811:16
admin
2019-11-0811:16
admin

Showing 13 out of 13items | 1 sel

Toolbar

o Create New: Lets you create a new policy. For more information, see Managing Policies.

o Publish: Publishes the selected policy.

« Edit: Lets you edit the details of an existing policy. For more information, see Edit a Policy.

« Delete: Deletes the selected policies permanently. For more information, see Delete a
Policy.

A Filter Panel
« Filters: You can filter policies based on Policy Type and Publication Status.

To hide, click the B icon at the top-right of the panel. To display if hidden, click the icon
in the toolbar.

« Reset: Removes the currently applied filter criteria.

For more information, see Filter Policies.
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RI Policies List Panel
Policy View. Displays the policy details:
o Policy name: Name of the policy.
o Applied to groups: Lists the group to which this policy is applied.
o Policy description: Displays the first portion of the description.

« Policy type: Displays the policy type: Agent Endpoint, Agent File Logs, or Agent Windows
Logs.

o Publication Status: Status of the policy: Published or Unpublished.

You can also sort on any column. If you mouse over a column header, a sort icon is displayed:
. Click the icon to sort by the selected column.

3 Policy Details Panel
Displays the properties of the selected policy.

Note: To view the Properties panel for a policy, click the Policy Name.

Create Policy

Below is an example of the Create Policy dialog. The table describes the information and options in the
Create Policy dialog.

RSA nvestigate 2espond Users Hosts Files Das s eports s Q) admin >
HOSTS  SERVICES  EVENT SOURCES ENDPOINT SOURCES ~ HEALTH & WELLNESS  SYSTEM  SECURITY

GROUPS POLICIES

E TEST EDR POLICY POLICY TYPE

Test anew EDR Policy Agent Endpoint

POLICY NAME

Define Policy Test EDR Policy

POLICY DESCRIPTION

Test anew EDR Policy

Cancel

Fod  oesplon

Policy Type  Displays the type for the policy. Available options are Agent Endpoint, Agent File
Logs, and Agent Windows Logs.
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Policy Name Name of the policy. The name should be unique.

Policy Description of the policy. Description should not exceed 8000 characters.
Description

Panels for Log File Policy

There are two panels for defining the parameters for an Agent Log File Policy: Define Connection
Settings and Define File Policy Settings.

Define Connection Settings

Below is an example of Define Connection Settings panel. The table describes the information and
available options.

HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

GROUPS POLICIES

& e
SRIERESY Available Settings Selected Settings

File Connection Settings File Connection Settings

»g Decoder / Log Collector e

O Enabled

Advanced Configuration R -
endpointloghybrid1 -

Throttle Network Bandwidth

Advanced Setting

Next Save and Close Publish Policy

o Do ————————————

Collect File  If enabled, the log file collection capability of the agent is activated. Logs are collected
Logs and forwarded to the RSA NetWitness Platform as they are generated. If disabled, no
defined event source logs are collected.

Note: This option must be enabled for any file event sources to be collected.

Send Test If enabled, a sample log is sent to the configured server when the policy is loaded to
Log test connectivity. This allows to test the configuration before standard logs are
available. By default, this option is disabled.
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Primary Log The primary Log Decoder or Log Collector to which the collected file logs will be

Decoder /
Log
Collector

Secondary
Log
Decoder /
Log
Collector

Protocol

Throttle
Network
Bandwidth

forwarded.

If the primary Log Decoder or Log Collector is not reachable, collected file logs are
forwarded to the secondary Log Decoder or Log Collector.

Note: The NetWitness Platform cannot detect failures when UDP protocol is used.

Select the transport protocol that is used to forward the collected file logs to the
NetWitness Platform servers. The following options are available:

o SSL: Recommended, but also the most resource-intensive option.

o TCP: Sends the logs in clear text over a reliable TCP connection. May be acceptable
within a corporate network.

o UDP: Sends the log in clear text over a non-guaranteed UDP connection. This is the
least resource intensive option.

Note: Resource intensity is dependent upon the Log Decoder, since there is only a
single connection per agent.

Advanced Configuration

Use this setting to limit network bandwidth that the Agent uses to connect to
NetWitness Platform. This setting is disabled by default: click Enabled to turn it on,
and then enter a value in kilobits per second.If not set, Agent does not do any network
throttling.If set to a positive value x, agent limits network bandwidth to x kbps.

Selected Settings

Advanced Configuration

10000
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Advlanced Caution: It is strongly recommended not to use this setting unless advised to do so by
Setting RSA.

Define File Policy Settings

Hosts Files

ENDPOINT SOURCES

LOG FILE TYPE

CiscoWorks
COLLECT LOGS

\iesv
Add Path

EXCLUSION FILTERS

Publish Policy

e

Log File From the drop-down menu, select the type of event source to be monitored.
Type

The list of available event source is based on all the event source types defined on your
RSA NetWitness Platform. You can add event source types using the Live Services
module. For details, see "Find and Deploy Live Resources" in the Live Services
Management Guide.

Collect If enabled, log files for this file type instance are collected and forwarded to the
Logs NetWitness Platform. File collection must be enabled on each source applying this policy
for these specific logs to be collected.

On First Determines whether the NetWitness Agent collects all logs or only newly created logs
Connect located in the specified paths upon initial collection. In both cases, new logs are
collected.

Note: Historical logs cannot be collected after an agent has begun collecting logs.
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Log File
Path

Exclusion
Filters

One or more paths to be used by the agent to locate the log files. Represents the location
of the log files to be read.

Note: The Path value cannot end at a directory—the final portion of the path must
represent a file name or set of files (using wildcard characters). You can use
wildcards for both files and directories.

Each source is limited to entry of 16 paths. This setting must include a path and a file
spec. For example: C: \Program Files\apache-tomcat-*\1logs\*.log. In this
case, the file spec is all files with a ".log" extension in the specified path.

If you cannot use wildcards to specify multiple files, you can add additional paths to
accommodate the differences in path locations on a specific endpoint agent. This might
be due to installation locations or version information. Only the paths with valid locations
and files on the specific endpoint agent are used, and the others are ignored.

For many event source types, there is a default path. If so, you only need to enter a path
if the log files are not stored in the standard directory for that event source type.

Note: This can be a standard Windows pathname (such as C: \Program
Files\Apache\error logs\logfile.log) or a UNC (Universal Naming
Convention) pathname (\\host-name\share-name\file-path). For more details
about UNC paths, see Endpoint Sources - Policies below.

An optional list of regex patterns which can be used to filter out any logs that match the
patterns. Each separate filter should be entered on a new line. Each source is limited to
16 exclusion filters.

Note: Each filter needs to be entered as a valid regex string, or the system does not
allow you to save it.

Advanced Settings
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Source Optionally, enter a hostname, IPv4 or IPv6 address to identify individual sources. This is
Alias recommended when there are two or more sources of the same type on the same server:
For example, a server that runs two instances of Apache web server.

Note: This value only rarely needs to be entered. One example is if you have more
than one Web Server, and they are running different Apache servers.

Note the following:

o If you enter a value for this parameter, the event source is applicable to a single
Endpoint server.

o This optional address or hostname is included in the meta for any logs originating from
this source. This can be used by analysts to assist in identifying the source.

« Set a value for this parameter if two sources of the same event source type are
configured in the same policy.

o This setting is not commonly needed: it is only useful if the policy is only applied to a
single endpoint.

File Specifies the type of character encoding of the log files. If Local Encoding is selected,
Encoding the NetWitness Agent uses the default encoding of the Windows machine upon which it
is running.

This setting must match the encoding of the log files, or they will not be processed
correctly.

Note: UTF-8/ASCII is recommended (and the default). UTF-8 is a super-set of ASCII

Note that all logs are re-encoded to UTF-8 before being sent to the NetWitness Platform.

For a list of the currently supported types, see Currently Supported File Log Event Source Types.

Define Policy Panel for Agent Endpoint Policy

Below is an example of Define policy panel. The table describes the information and options for Agent
Endpoint policy:
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RSA te R Users  Hosts  Files  Da ds  Reports E X @ admin>
HOSTS SERVICES EVENT SOURCES ENDPOINT SOURCES HEALTH & WELLNESS SYSTEM SECURITY

GROUPS  POLICIES

S
INSIGHT Available Settings ¢ Selected Settings ©

Scan Schedule Agent Mode

Run Scheduled Scan
MONITORING MODE
Insights.
O Advanced

EXPANDED NETWORK VISIBILIT
O Disabled
Enabled

Scan Settings Endpoint Server Settings

Scan Master Boot Record
HTTPS BEACON INTERVAL
Auto Scan New Hosts When Added
1 Minutes

Download Settings CruaL
Automatic File Downloads
X Seconds
Signature

Saveand Close | | PuBIish Policy

Scan Schedule

Run Run a scheduled scan if you want to receive regular snapshots from a host. Scan
Scheduled snapshots provide detailed information about processes and files loaded on the memory.
Scan By default, this option is disabled.

You can also run a manual scan from the Hosts view.

Note: The following scan schedule options are available only when the scan schedule
is enabled.
The values entered are specific to the agent time zone.

Effective Date when the policy takes effect. If you do not want this policy to take effect as soon
Date as it is applied to a group and published, set an effective date that is in the future. By
default, this is set to the current date.

Scan Determines how often the scheduled scan runs on a host. By default, this is set to every

Frequency week. Every network is different and the frequency should balance the needs of the
analysts for current data, availability to review the data, and how systems deal with the
load of the generated data.

Select Days or Weeks:

« Days: Select the number of days of the scan frequency. You can set a schedule to
scan every n days, where nis 1, 2, 3, 4, 5, 6, 10, 15, or 20. For example, to scan
every third day, select 3.

o Weeks: Select after how many weeks the policy scan should be initiated and on
which day of the week the policy scan should initiate. For example, to scan every
other Wednesday, choose 2 and W.
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Start Time

CPU
Maximum

Virtual
Machine
Maximum

Monitoring
mode

(Version
11.5 and
Later)
Expanded
Network
Visibility

Scan Master
Boot Record

Time when the scheduled scan starts to run on a host. By default, this is set to 9:00.
This is the local host time, meaning that scans across a global network will not run all
at once. Note that the time is in 24 hour format. To set a time of 7:30 PM, select 19:30.

Amount of CPU the agent can use to run scheduled scans on physical hosts. By default,
the value is set at 25%. Increasing the CPU maximum increases the speed of scan
snapshot retrieval.

Drag the slider to specify the maximum CPU usage by the created policy. Minimum
value is 5%. Use the slider to select the maximum CPU processing power to use for the
scan. Note that the higher the percentage, the less CPU is available for other tasks on
the host.

Amount of CPU the agent can use to run scheduled scans on virtual machines. By
default, the value is set at 10%. Increasing the virtual machine maximum value
increases the speed of scan snapshot retrieval.

Drag the slider to specify the maximum Virtual Machine usage by the policy. Minimum
value is 5%. Use the slider to select the maximum CPU processing power to use for the
scan. Keep in mind that the higher the percentage, the less CPU is available for other
tasks running on the virtual machine.

Agent Mode

Allows you to specify whether an agent should operate in Insights (free) or Advanced
mode (license). By default, it is set to Advanced.

Enables network tracking and monitoring on Windows hosts in Insights mode.

Note: For network tracking in Insights mode, verify that the Windows Management
Instrumentation (WMI) service should be enabled.

It also optimizes the frequency of agents sending network events for network packet
correlation for both Insights and Advanced modes. By default, this option is disabled.

Scan Settings

Includes Master Boot Record (MBR) details in scheduled scans. By default, this option
is disabled. This can help to identify when an operating system boot sequence is
compromised. However, not all modifications to the MBR are malicious, as they could
be made to provide encryption or enforce licensing of certain legitimate software.

Auto Scan Automatically scans when a new host is added. By default, this option is disabled. If
New this option is disabled, no snapshot data is displayed in the Hosts view until a manual or
Systems scheduled scan is run on these hosts. Existing hosts will not be affected.
When
Added Note: Enabling this option on a new deployment when this policy is applied to a large
number of hosts may result in a large number of simultaneous scans that cause
performance degradation.
Download Settings
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Automatic
File
Download

Signature

File Size
Limit

Blocking

Network
Isolation

Endpoint
Server

Server Alias
(Optional)

Automatically download the files to the NetWitness Endpoint Server based on the file
size and signature. If a file is present on multiple hosts or multiple Endpoint Servers,
only one instance of the file is downloaded. By default this option is enabled.

Limits the download of files based on the signature. The options are :

o Exclude All Signed - Downloads all the unsigned files to the NetWitness Endpoint
Server and exclude all the signed files.

« Exclude only Microsoft and Apple signed - Downloads all the unsigned files and
exclude the files signed by Microsoft and Apple.

¢ Include All- Downloads all the signed and unsigned files.

Note: . In case of Linux, Exclude all signed and Exclude Microsoft and Apple
signed options will download the files that are not part of any installed RPMs or files
which are part of RPM but the hashes does not match with RPM.

Limits the download of files based on the file size. The File size should be between 1
KB and 10 MB. By default, file size lesser than or equal to 1 MB are downloaded
automatically.

Response Action Settings

Allows an analyst to prevent the execution of a malicious file on any host running an
Advanced mode agent. By default, this option is disabled. File blocking will not be
enforced if it is disabled by policy, which might be desirable to ensure that there are no
performance side effects on systems where CPU or 10 performance is critical.

Note: Blocking is only supported on Windows agent (in Advanced mode) with
NetWitness Platform version 11.3 and later.

Allows an analyst to block hosts that are compromised from connecting to the network.
This controls the spread of an attack and help analyze the malware behavior after the
network isolation. All attempted network connections are monitored and reported to the
Endpoint Server. By default, this option is disabled.

Note: Network isolation is only supported on Windows agent (in Advanced mode)
with NetWitness Platform version 11.4 and later.

Endpoint Server Setting

Displays all available Endpoint servers in the deployed.

Note: If you do not select an Endpoint Server, the agent uses the default Endpoint
Server that is configured during packager generation.

The optional server alias allows you to enter an alternative hostname or IP address on
which the server can be reached in the case that agents need to go through a NAT or
similar in order to reach the Endpoint Server.
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HTTPS Port Port number used for HTTPS communication. By default, the port is set to 443.

If you want to change this port, make sure that it matches the server configuration. If
you enter the wrong port, the agents can no longer communicate with the Endpoint
server and the system will be non-functional.

HTTPS Determines how often an agent can communicate with the Endpoint server over
Beacon HTTPS. By default, the value is set to 15 minutes. The default method of beaconing is
Interval UDP. Beaconing is used as a method of keep-alive to know if a host is online and to

allow hosts to respond faster than the fallback HTTPS beacon time.

UDP Port Port number used for UDP communication. By default, the port is set to 444.

If you want to change this port, make sure that it matches the server configuration.
Entering the wrong port results in loss of functionality and effects performance.

UDP Determines how often an agent can communicate with the Endpoint server over UDP.
Beacon By default, the value is set to 30 seconds.
Interval

Define Policy Panel for Windows Logs Policy

The table describes the information and options for Agent Windows Logs policy:

Available Settings Selected Settings

Windows Connection Settings

Channel Filter Settings

®

CHANNEL NAME FILTER EVENT ID

System INCLUD... ALL

Previous Publish Policy Cancel
m Description
Windows If enabled, logs from the Windows hosts are collected and forwarded to the NetWitness
Log Platform. By default, this option is disabled.
Collection

Send Test If enabled, a sample log is sent to the configured server when the policy is loaded to
Log test connectivity. This allows to test the configuration before standard logs are
available. By default, this option is disabled.
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Primary Log Primary NetWitness Platform Log Decoder or Log Collector to which the collected

Decoder /
Log
collector

(Optional)
Secondary
Log
Decoder /
Log
collector

Protocol

Channel
Filters

Throttle
Network
Bandwidth

Windows logs are forwarded.

If the primary Log Decoder or Log Collector is not reachable, the collected Windows
logs are forwarded to the secondary Log Decoder or Log Collector.

Note: NetWitness Platform cannot detect failures when UDP protocol is used.

Select whether TLS, TCP, or UDP transport protocol is used to forward the collected
Windows logs to the NetWitness Platform servers. By default, the protocol is TCP.

Configure which Windows Log events to collect by selecting a channel, filter condition,
and the relevant event IDs. You can either select common channels, such as Security or
System from the drop-down list, or create custom channels by entering the channel
name. By default, all events are collected from a selected channel.

To collect a subset of events from that channel replace 'ALL' with the relevant Event
IDs. Select INCLUDE if only events with the listed Event IDs should be collected or
select EXCLUDE to collect all events except for these events.

Advanced Configuration

Use this setting to limit network bandwidth that the Agent uses to connect to
NetWitness Platform. This setting is disabled by default: click Enabled to turn it on,
and then enter a value in kilobits per second.

o Ifnot set, Agent does not do any network throttling.

o If set to a positive value x, agent limits network bandwidth to x kbps.

Selected Settings

Advanced Configuration

10000
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Ad\{anced Caution: It is strongly recommended not to use this setting unless advised to do so by
Setting RSA.
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Troubleshooting

This section provides information about possible issues when using RSA NetWitness Endpoint.

Agent Communication Issues

Agent Last Seen Time column is not updated in the UI.

The issue could be due to any one of the following:
o Agent is inactive

o Agent data is not processed if the Endpoint.Health.Overall-Health statistic shows
Unbhealthy due to which all the agent data including agent last seen time is not
updated.

See the resolution for these statistics in the Health and Wellness Issues section.

Agent is unable to communicate with the Endpoint Server.

This could be due to one of the following reasons:

o Agent is inactive.

« Endpoint Server settings is incorrect in the agent packager or policy configuration,
or not available for communication.

o Endpoint Server or Nginx Server is not running .

o Firewall or IP table rules are blocking the connection between the host and
Endpoint Server.

o Check if the Endpoint Server and Nginx Server are reachable.

« If the Endpoint Server settings are incorrect, uninstall the agent, download the
agent packager, and reinstall the agent.

o Update firewall or IP table rules, if required.

Agent takes a long time to scan.

Sometimes, the NetWitness Endpoint scan takes a long time to complete. This is
because of the CPU usage by other antivirus programs (such as Windows Defender,
McAfee, Norton, and so on) that may be installed on the agent machines.

It is recommended to whitelist the <service.exe> (name provided in the packager,
by default, the service name is NWEAgent . exe) file in the antivirus suite.

You want to change the responsiveness of the Agent.
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Depending on your installation, you can adjust Beaconing intervals to change how
responsive your agents are.

If resources are not a concern, you can lower the HTTPS Beacon Interval and UDP
Beacon Intervals. If resources are a concern and responsiveness of the agent is not,
you can increase these intervals.

Agent is unable to generate network tracking events in Insights mode.

Verify that Windows Management Instrumentation (WMI) service is running.

e Run Services.msc and look for Windows Management Instrumentation (WMI)
service.

o Go to properties and change the Startup type to Automatic.

Packager Issues

Failed to load the client certificate.

Incorrect certificate password.

While generating the agent installer, the certificate password does not match with the
one provided while downloading the agent packager from the UL

Specify the correct certificate password.

Health and Wellness Issues

Endpoint Issues

The health check of the Endpoint.Health.Overall-Health statistic shows Unhealthy.

Endpoint Server service or required resources are not available or not in a usable state.
This could be due to one of the following reasons:

o Unable to forward Endpoint meta data to the Log Decoder.
« Endpoint Log Hybrid disk usage reaches the specified limit.

« Mongo DB is down or excessive read and write errors during processing.

o For Log Decoder issue, see Log Decoder Issues section.

« For disk usage and Mongo DB issues, see Disk Usage and Mongo Issues section.
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Disk Usage and Mongo Issues

The health check of the Data.Application.Connection-Health Application, Data
Store Disk Usage or Data Persistence for Endpoint Server shows Unhealthy.

o Data.Application.Connection-Health Application or Data Persistence shows
Unhealthy, if Mongo service is down or fails due to authentication.

« Data Store Disk Usage shows Unhealthy, if Endpoint Server Mongo storage size
has exceeded the threshold. By default, the server automatically delete the old data
when it reaches 80% of the disk space.

o For Data.Application.Connection-Health Application or Data Persistence issue,
you must check the Endpoint server logs (/var/log/netwitness/endpoint-
server/endpoint-server.log) and Mongo logs
(/var/log/mongodb/mongod. log), and:

o If the issue is due to authentication, you must reissue the certificate. For more
information, see "Service Certificate Reissue" section in the System Maintenance
Guide.

o If the issue is due to Mongo service is down, you must restart the Mongo.

o For Data Store Disk Usage issue, you must increase the storage or configure data
retention settings to clear the old data. For more information, see Configuring Data
Retention Policy.

Log Decoder Issues

Endpoint metadata is not available in the Investigate > Navigate or Events view.

The health check of the Log Decoder Buffer and Meta Forward shows Unhealthy
in the Health and Wellness.

The issue could be due to any of the following reasons:
o Log Decoder capture is not started.

« Concentrator aggregation is not started.

o Log Decoder connection issue.

o Log Decoder buffer usage is beyond the specified limit.

Make sure that:
o Capture is enabled on the Log Decoder.
o Aggregation is enabled on the Concentrator.

o Meta forwarding is configured properly.
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Concentrator.

Note: Make sure Capture Autostart is enabled in the Service Config view for Log
Decoder and Aggregate Autostart is enabled in the Service Config view for

File Log Policy Issues

Invalid Policy or Bad Connection Issues

Policies can be invalid for a variety of reasons. Some examples:
« No sources found if the policy is enabled.
o Invalid or missing typespec file

« No destination is reachable for a file log policy event source type

Additionally, if capture is stopped on the destination Log Decoder, Endpoint
Agents will send an error to the Endpoint Server saying that they failed to connect.

Also, if there is a lot of data to be processed for Agents collecting File data (when
File Policy is enabled) , there is a possibility that Log Decoder buffer becomes
full. If this happens, the Log Decoder cannot process any requests from the Agents
communicating via EPS.

The system is dynamic in nature, which means its state can change: event sources
can lose their connection, typespec files can be altered or deleted, and other
changes can occur that can invalidate a previously valid policy.

To help identify the specific issue, check the log file on the Endpoint Server that
reports the error:

/var/log/netwitness/endpoint-server/endpoint-server.audit.log
Relevant errors will be listed as FileLogError in the log file.
If you experience this issue, you can do the following:

1. Try to identify and target higher-value data, thus limiting the total amount of
data being processed.

2. Enable throttling in the File policy to smooth out the peaks in usage.

3. If youreally do need to process more data on a regular basis, consider server-
side hardware upgrades.

Reset File Collection Bookmarks

If the system is not configured correctly, NetWitness Platform might collect logs
and not be able to parse them. Or, files might get sent, but for some reason, not
make it to the Log Decoder (for example if communication is via UDP and there is
a network connectivity issue).

Troubleshooting
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In these and other cases, you can reprocess these "missing" log files.

For whatever reason, you may need to reprocess logs from the beginning of the
file.

Reset bookmarks for an event source type using the procedure described here:
Reset File Collection Bookmarks.

Missing Log Collectors and Event Sources in the User Interface

Some log collectors or event sources seem to be missing from the list of available
items.

The Filter drop-down menus (types, log collectors, and log decoders) only show

values that are in the event sources database, rather than all possible values. For
example, if you have a log collector that has not yet collected any logs, then it is
missing from the list.

Collect logs from a specific log collector and event source, and then they should
appear as items in the appropriate menu.

Relay Server Issues

Test Connection Issues

Relay Server test connection failed.

1. Check if the hostname or IP and port of the Relay Server are correct.

2. Make sure that the hostname or IP of the Relay Server is resolvable from the
Endpoint Server. Perform the following:

a. Inthe Endpoint Log Hybrid console, verify if the Relay Server is reachable
using the following command:
nc -zvw3 <relayhost> <relayport>
If the Relay Server is not reachable contact your Administrator.

b. If the Relay Server is reachable, verify if the correct Relay Server installer
is used by getting the Endpoint Server revision ID from the Relay Server
host (/var/log/relay-install.log) and check the Endpoint Server
RPM on Endpoint Log Hybrid using the following command:
rpm -ga | grep <Endpoint Server Revision ID>

c. Make sure if the Relay Server is installed and running.

« Verify the Relay Server installation logs using the following command:
/var/log/relay-install.log

o Verify the status of Relay Server using the following command:
systemctl status rsa-nw-relay-server
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Relay Server installer generation fails with an error message ‘Unable to download
the installer. Retry after sometime’.

Dependencies of the Relay Server are not resolved or downloaded completely.

You must retry the download after 5-10 minutes. If the download still fails even
after all dependencies are downloaded in the Endpoint Server, contact the RSA
Customer Support.

Note: You can check ‘Finished downloading all Relay Server dependencies’
message in the Endpoint Server logs at /var/log/netwitness/endpoint-
server/endpoint-server.log, to see if the dependencies are downloaded.
If the download fails due to yum related issues, then you must clean yum repo
using the command yum clean all and restart the Endpoint Server.

Installation Issues

Relay Server installation fails due to missing or corrupted dependencies.

1.
2.

Re-download the installer dependencies, perform the following:

a4
Go to (Admin) > Endpoint Server service > select T > View > Explore.

In the Endpoint server configuration, make sure
endpoint.relay.installer.download-on-restart boolean is set to true (by default it is
true).

Restart the Endpoint server using the following command:

systemctl restart rsa-nw-endpoint-server

Fresh dependencies will be downloaded to the local directory in the Endpoint
Server. This may take few minutes.

Download the Relay Installer.

Run the Relay Server Installation Script.
For more information, see (Optional) Installing and Configuring Relay Server.
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Reset File Collection Bookmarks

In cases where issues have caused logs to be lost, or not correctly sent to the Log Decoder, you can
resend messages in log files by resetting the bookmarks for those log files.

Note: For security reasons, RSA does not allow resetting bookmarks from the agents. Rather, you
must do so from an Endpoint Server.

The following procedure describes how to reset bookmarks for file collection logs.

Note: Currently, you can reset bookmarks for all sources or just one specific source, by providing a
list in a JSON file.

Construct a JSON File to Identify Agents and Event Source Types for

Reset

First, you need to construct a JSON file using the following structure:
{

"agentIds": [],
"sourceType"

wn

}

where:

e agentIds: a list of the IDs for one or more Endpoint Agents: these are the individual agents on
which the source log files reside.

e sourceType: this is a list of the file event source type or types for which you want the log file
bookmarks to be reset.

For details on finding agent IDs and source types, see How to Find Agent IDs and Source Types below.

For example, the following source code snippet could be used to delete bookmarks for all sources on 3
agents:

{

"agentIds": ["43F27B6E-A02D-955A-9607-2DFC5D17B6ET",
88AD4B2C-192B-B50E-A125-C0O5B801301AA"
"3899038D-8F42-BC93-5BA7-ECBFC309D6A3" ],

"sourceType": "ALL"

}

Similarly, the following source code snippet could be used to delete bookmarks for apache sources on 3
agents:

{
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"agentIds": ["43F27B6E-A02D-955A-9607-2DFC5D17B6ET",
88AD4B2C-192B-B50E-A125-C0O05B801301AA"
"3899038D-8F42-BC93-5BA7-ECBFC309D6A3" ],

"sourceType": "apache"

Reset Bookmarks

Perform the following steps to reset the bookmarks that you specified in a JSON-formatted file:
1. SSH to the NetWitness Platform Admin Server.

2. Run nw-shell command. for details about using the NetWitness shell, see the Shell User Guide,
available in RSA Link.

3. After nw-shell starts, connect to an Endpoint Server service, using the following command:
connect --service endpoint-server.servicelD

where servicelD is identifier for the Endpoint Server that hosts the agents you are changing. See
How to Find Endpoint Service IDs for details on how to retrieve the service ID.

4. Change to the directory where the reset command resides:
cd endpoint/command/reset-bookmark

5. Login with an administrator account.

a. Type the login command:

login
b. Enter the user name for your admin account.
c. Enter the password for your admin account.

6. Run the reset command: you need to provide the JSON path and filename that you created earlier.
invoke --file <path and filename for JSON>
For example:
invoke --file /tmp/test.json

The bookmarks for each log file identified in your JSON file are reset. The following image shows an
example NetWitness Platform Shell session:
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A »:#_ﬂu—shell

» connect --ser e endpoint-server.

» cd endpoint

How to Find Agent IDs and Source Types

To find the Agent IDs for agents, go to Hosts > <select an Agent>, then click the Host Details panel,
and scroll down to the Agent section, where the Agent ID is shown:

HOST DETAILS POLICY DETAILS
DNS

Promiscous

Operating System
Description  Microsoft Windows Server 2008 ...
Build Number 7601
Service Pack 65536
Kernel Name ntoskrnl.exe

Kernel Release  2017-02-09T15:57:17.000Z

Agent

AgentID  3899038D-8F42-BC93-5BA7-E...

Install Time  10/15/2019 10:36:55.915 pm

Service Start Time  10/15/2019 10:37:02.061 pm

To find the source types, go to Hosts > <select an Agent>, then click the Policy Details panel, expand
Agent File Logs, view the Source Settings for the source type name to use:
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HOST DETAILS POLICY DETAILS

Connection Settings
Collect File Logs  Enabled
Primary Destination 10.101.216.97
Protocol TLS

Send Test Log  Disabled

Source Settings|(apa

Collect Logs Enabled

On First Connect  Collect new data only

File Encoding UTF-8/ ASCII

Paths  C:\Program Files\Apache Group\...

How to Find Endpoint Service IDs
You can retrieve the service ID for an Endpoint Server by using SSH to connect to it.

To retrieve the service ID for an Endpoint Server:

1. SSH to the NetWitness Platform Endpoint Server for which you need to retrieve the ID. The IP
address is available under (Admin) > Hosts. The IP address for each host is listed in the Host
column of the table.

2. View the file that contains the ID by running the following command:
cat /etc/netwitness/endpoint-server/service-id
It returns the Endpoint Server ID, for example:
38909c2f-7a%0-415a-b567-£49a19c£250e
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Currently Supported File Log Event Source Types

The following event source types are currently supported:

Apache Tomcat
CiscoWorks

Courion Password Courier
GlobalSCAPE EFT Server
IBM WebSphere MQ
McAfee Endpoint
Microsoft Exchange 2007
Microsoft Exchange 2016
Microsoft IAS (TVM)
Microsoft ISA PF

Oracle Access Management
Oracle WebLogic Audit Recorder
Perforce P4D

RSA Access Manager
RSA ACE Server AM
RSA Certificate Manager

Steel-Belted Radius Accounting

Apache Web Server
CiscoWorks

EMC NetWorker

IBM TAM WebSEAL
JBoss Application Server
Microsoft DHCP
Microsoft Exchange 2010
Microsoft Exchange SMTP
Microsoft ISA

Microsoft SQL Server
Oracle iPlanet Web Server
Perforce

Rapid7 NeXpose

RSA ACE Server

RSA ACE Server AMX
RSA Federated Identity Manager

Steel-Belted Radius Authentication

CA Siteminder

Citrix XenMobile Device Manager
EMC Symmetrix

IBM WebSphere

Kaspersky Anti-Virus

Microsoft Exchange

Microsoft Exchange 2013
Microsoft Forefront Threat Management Gateway
Microsoft ISA 2006

MSIAS

Oracle WebLogic

Perforce AL

RIM Blackberry Enterprise Server
RSA ACE Server

RSA Adaptive Auth (Hosted)
SAP ERP Central Component

SunOne LDAP Directory Server

Trend Micro IMSS Trend Micro IWSS Trend Micro IWSS Audit
VMware View Windows DNS Debug Logs
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Specify UNC (Universal Naming Convention) Paths

During configuration of a Log File Policy, you can specify the log file path. You can set one or more
paths to be used by the agent to locate the log files. The path can be a standard Windows pathname
(suchas C:\Program Files\Apache\error logs\logfile.log)or a UNC (Universal Naming
Convention) pathname (\\host-name\share-name\file-path). This topic describes how to specify
a UNC path.

Secure the UNC Path Location

When you use a UNC path to collect log data on a remote system, make sure that you secure the UNC
path location. One solution that works with minimal risk in a Windows domain environment is to do the
following:

1. Create a share on the directory on the computer where the log data exists in isolation.

2. Name the share to something like LOGDATAS for example. (Shares can be hidden from curious
browsers by adding a "$" to the end of the share name).

3. Remove all the default share permissions except local admin so it can be changed.

4. Add a share permission for the agent computer system. This allows any user on the agent system to
access the shared location. On the agent system collecting the remote log data, nothing else should
be required to properly collect the log data from the UNC path.

Note: You may not be able to view the UNC directory contents from file explorer. Seek advice from
your IT or security group for additional guidence to setting up and securing a UNC directory share.

The following procedures describe how to:

o Share a folder between machines in a domain, and

o Share a folder between machines in a Workgroup

Share a folder between machines in a domain

This procedure describes how to share a folder between Windows machines that are both in the same
domain.

1. Log on to a Domain member machine that contains the logs folder you want to collect using an
agent.

2. Right click on the folder you want to share with the agent to collect logs from, and click Properties:
SHARES in this example.
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] SHARES Properties B

Ganaral Sharing Security Previous Varsions Customize

Metwork File and Folder Sharing

SHARES
j Mot Shared

Metwork Path:
Mat Sharad

Share...

Advanced Sharing
Set custom permissions, create multiple shares, and set other
advanced sharing oplions.

“¢ Advanced Sharing...

Ok Cancel \pply

3. Click Advanced Sharing, select Share this folder, and then click Permissions.

Advanced Sharing .
[+] Share this folder
Settings
Share name:
| sHARES |
Add Remave

Limit the number of simultaneous users to: 16777 5

Comments:

Permissions || Caching |

| QK || Cancel || Apply |

4. Click Add, and then on the next window click Object Types, check Computers, hit OK.
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] Permissions for SHARES

Share Pemissions

B3

GI'DUD or USer Nnames:

82 Everyone

Select Users, Computers, Service Accounts, or Groups

Select this object type:

|Users. Groups, or Builtin securty principals

From this location:

| DC_SYSTEMJocal

Enterthe object names to select (examples):

B3

| Chbject Types...

| Add... | | Remove |
Permissions for Everyone Alow Dery
Full Control O O
Change O O
Read O
oK | | Cancel Apply

Object Types
Select the types of objects you want to find.

Object types:

O @ Service Accounts
[ E,Ej Computers
%Gmups

E) Users

oK

| | Cancel

5. Search for the Agent computer name as shown below and click OK.

Select Users, Computers, Service Accounts, or Groups .

Select this object type:

|User5‘ Computers, Groups, or Buitt4n security principals ‘ | Object Types... |
From this location:

[pc_s¥sTEMIoca | [ Locations... |
Enter the object names to select (zamples):

DM WINAGENT1 Check Names

6. In the Permissions screen, provide Read permission to the agent, click Apply, and then click OK.
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Share Permissions

I:3I'0LI|:J ar user names:

Pemissions for
DM_WINAGENT1

Full Control
Change
Read

7. Remove Everyone from the Share Permissions list.

Permissions for Shared X

Share Permissions

GI'OUD Or user names:

DM_WINAGENT1 (DC_SYSTEMO\DM_WINAGENT1$)

Permissions for

DM_WINAGENT1 Allow Deny
Full Control a O
Change O O
Read ™ O

[ ok ]| cancel || Aol

8. Verify that now the SHARES folder status is correct, and note the network path so that you can enter
it later, when you configure the policy that will use this shared folder.
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|Ganaral Sharing :Mﬁty] Pravious Varsions| Customize

Metwork File and Folder Sharing

SHARES
. Shared

Metwork Path:
WDm_winagent2\share$

Share...

Advanced Sharing

Set custom permissions, create multiple shares, and set other
advanced sharing opfions.

“ Advanced Sharing... |

Share a folder between machines in a Workgroup

This procedure describes how to share a folder between Windows machines that are both in the same
Workgroup.

1. Log on to a workgroup machine that contains the logs folder you want to collect using an agent.

2. Create a non-admin user for log collection: Reader in this example.

File Action View Help
e 2@ XE = HE

& Computer Management (Local | Name Full Mame Description Actions
4 'ﬁ’& Systemn Tools §|Administrator Built-in account for administering...
& Task Scheduler #Guest Built-in account for guest access t... _
b ] Event Viewer Reader Share Log Reader More Actions ’
b | Shared Folders

4 8 Local Users and Groups | Reader &

] Users More Actions »

7] Groups
I @ Performance
£ Device Manager
4 % Storage
[» ﬁ Windows Server Backug
=% Disk Management

[ ﬂ} Services and Applications

3. Right click on the folder you want to share with the agent to collect logs from, and click Properties:
SHARES in this example.

4. Click the Sharing tab, then click Share.
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| General | Sharing |Sewnty I Previous Versions I Customize

Metwork File and Folder Sharing

SHARES
l . Not Shared

Network Path:
Mot Shared

Advanced Sharing

Set custom permissions, create multiple shares, and st other
advanced sharing options.

| ) Advanced Sharing...

Password Protection

People must have a user account and passwaord for this
computer to access shared folders.

To change this setting, use the MNetwork and Sharing Center.

5. Choose the newly-created user and click Add.

Choose people to share with

Type a name and then click Add, or click the arrow to find someene.

v|][Add
Name Permission Level

2 Administrator Read/Write ¥

52 Administrators Owner

I'm having trouble sharing

6. Select the Read permission and click Share.

Choose people to share with

Type a name and then click Add, or click the arrow to find someone.

[ V][ add
Name Permission Level
2 Administrator Read/Write v
52, Administrators Owner
2 Reader Read *|[ /]| Read
Read/Write
Remove

I'm having trouble sharing
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7. Log onto the Agent to add credentials, so that the system can read logs from the shared folder.

a. Download the psexec tool from the Microsoft web site.
b. Run the following command:

psexec -i -s cmd.exe

A new command window opens, running as system.

¢. Inthe command window, run the following command to cache credentials for the newly-created
user to access logs on shared folder from a workgroup machine:

net use \\hostname of machine with logs\Share$
For example:
net use \\WGWINAGENT2\Share$

d. Provide the username and password for the non-admin user created earlier (in step 2).

@ Administrator: C:\Windows\system3... = | -

This command adds credentials to read logs from the shared folder on the workgroup machine.
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